Skycut Series V with SignMaster

March 17, 2023

Do NOT read this entire manual... unless you want to.

e At the start of Chapters 1 - 4 are short sections with references to find what you need plus some important
reminders. PLEASE read these short sections at the very least and refer back to them, when needed.

e Chapters 1 and 2 are very important in terms of correctly setting up your Skycut to work with SignMaster
and learning the ins and outs of cutting.

e Chapter 3 is for those owners wanting to perform print and cut applications.
e Chapter 4 covers using Skycut accessory tools.

e Chapter 5 covers several SignMaster functions of interest: creating contour cuts and engraving fills.

It’s not practical to print this entire manual because:

e |t's a waste of paper and ink if you only ever need certain sections.
e The live links to videos and web sites in the manual will not work.
e This manual will be updated from time to time.

e You cannot search on individual words.

Also:

e Note the green O icons which link to videos related to the section in which they are located. These
videos will enhance your learning experience.

© 2018-2023 Sunrise Electronic Technology Co., Ltd. All Rights Reserved


https://www.youtube.com/watch?v=HguV1rMFbqg
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1. Introduction and Setting Up

1.00 Quick Reference for This Chapter

e How to download and set up SignMaster: Section 1.11

e How to set up communication between a computer and Skycut: Section 1.12
e How to use the control panel: Sections 1.10 and 1.14

e How to adjust the blade holder: Section 1.07.5

e Where to position the pinch wheels: Section 1.09

e The cutting mat is too sticky (or not sticky enough): Section 1.08

e How to use the USB Flash Drive feature: Section 1.12.4

Important Notes:
o Please read Section 1.02 regarding safe operation of the Skycut.
¢ Report any damage or missing contents to your dealer promptly.

e Retain the original box and packing materials in case you ever need to ship your Skycut.

1.01 Support

e Thank you for choosing a Skycut digital die cutter. Before using a blade in your new cutter, we urge you to
read Chapters 1 and 2 and watch the videos linked in these chapters.

e If you run into difficulties with the operation of your Skycut, turn off the power and look for a solution in this
manual. Note that Appendix A is a Troubleshooting section. If you continue to have technical questions or
issues, please contact your dealer as soon as possible.

e |f anything is missing from your order or you have mechanical issues with your Skycut, please contact your
dealer as soon as possible. You can also contact Skycut directly using this email address:
skycut@skycut.cn.

e For additional information and support with the Skycut, please check out the following:

¢ Skycut web site: http://www.sky-cut.com/

¢ Skycut Facebook page: https://www.facebook.com/skycutcuttingplotter/

¢ Skycut YouTube channel: https://www.youtube.com/channel/UCrPn5hFLbiIRNDgccY 8iXwoA

e For SignMaster support, please go to http://signmaster.software/support/

1.02 Safety and Warnings

Please be aware of the following safety guidelines when working with the Skycut:
e Pinch Points: Keep hands, long hair, loose clothing, jewelry, etc. away from the moving parts.

e Risk to Children and Pets: Please supervise children around the cutter when it is in use.

e Movement and Touching: Do not move the Skycut or touch any circuitry while it is plugged in.

e DO NOT touch or jam the plotter’s track while it is operating. If the cutter is damaged, it is the owner’s
responsibility.


http://signmaster.software/support/

DO NOT shake the cutter while it is operating.
DO NOT cut any materials that have staples or other embellishments attached.

DO NOT touch the cutter with a magnet. It is safe, however, to cut magnetic materials, such as those used
on refrigerators and car exteriors.

DO NOT allow any liquids to spill into the cutter.
DO NOT allow small items to fall into the cutter.
Place the Skycut on a sturdy and stable table, desk, or trolley. The optional Skycut stand can also be used.

Always turn off the Skycut when not in use. Leaving the cutter turned on for extended periods of time can
possibly damage the machine.

Always turn off the Skycut before unplugging or removing the power cable from the wall outlet or power
strip.

Unplug the Skycut from a wall outlet or power strip during an electrical storm or when the cutter will not be
used for an extended period of time.

Transporting: When transporting the cutter, move the pinch wheel lever into the upward position. Remove
the blade from the blade holder and cover the tip with the plastic cap.

1.03 Warranty

IMPORTANT! If your Skycut is damaged during shipment or appears to be defective, your dealer should be
notified as soon as possible.

For additional information regarding your warranty, please refer to your Skycut dealer.

It is recommended that you retain the original box with packing materials in case you ever need to ship your
Skycut.

1.04 Unpacking

Verify that you have received all contents. There is a checklist in Section 1.05. Please notify your Skycut
supplier immediately if anything is missing.

Remove all packaging before turning on the Skycut. Currently, the cutter ships with two end cap foam
protectors, four plastic zip ties, and tape on either end of the cutting strip. Be very careful when removing
the zip ties - it's best to cut those ties from behind the machine versus in front. Gently remove the tape at
the ends of the cutting strip by rolling the tape away. Do not pull straight up.

Because the cutting mat must be folded over to fit into the box, it may have become slightly rounded during
shipping. Gently and only partially roll the mat in the opposite direction to remove the roundness and place

on a flat table to make sure the mat now lies horizontally to the surface. Refer to Section 1.08 for additional
instructions on preparing the mat for use.

Use the enclosed test pen as you experiment and become familiar with operating the Skycut. Place scrap
paper on the mat and simply draw shapes rather than cut them. This will prevent possible damage to the
blade, mat, and cutting strip as you learn where shapes will cut and the basic operating procedures.

1.05 Contents

Besides the cutter, your box should also contain the following items:



Description Quantity

1 Power cable 1
2 USB Cable 1
3 60° Blade(blue cap) —s——3 1

4 45° Blade(red cap) e 2

6 Test Pen and 1 Refill 1set

5 Blade Holder __ 1

7 Cutting Mat

1.06 Parts of the Skycut

Front

. Cutting Strip Alignment Marker
Pinch Wheel (It. gray)

Control Panel

Left —»
End Cap

Ruler

Front Grit Shaft (dark
Table gray and rough)

Blade Blade Holder Seat (Jaw)
Carriage



e Alignment Markers: indicate to the user the available positions for the pinch wheels

e Blade Carriage: moves the Blade Holder Seat left and right

e Blade Holder Seat or Jaw: holds the blade holder, test pen, and other accessories

e Control Panel: used to change settings, set up Wi-Fi, calibrate camera, cut PLT files, and more
e Cutting Strip: protects a blade when cutting backed materials without using a cutting mat

o Front Table: keeps cutting mat supported horizontally

e  Grit Shafts (5 on 24” model): allow the pinch wheels to grip the mat or material so they can be moved in and
out of the cutter during cutting

e Pinch Wheels (4 on 24” model): grip the mat or material so that the grit shafts beneath will feed the mat or
material in and out during cutting

e Ruler: for measuring and aligning rolled materials

Right Side

e USB Flash Drive Port: used to load PLT
files via control panel for cutting

e USB Port: option to connect computer to
Skycut with included USB cable

e Reset Button: used to reset Skycut’s
cutting buffer (does not reset calibrations)

Reset
USB Flash USB Port Button
Drive Port
Left Side

e Power Port: plug power cable into this port
e  On/Off Switch: power cutter on or off

Power Port On/Off
Switch

Pinch wheels

Pinch Wheel Lever
Back Table



e Pinch Wheels (4 on 24” model): grip the mat or material so that the grit
shafts beneath will feed the mat or material in and out during cutting Note: Newer models no

e Pinch Wheel Lever: raises and lowers the pinch wheels longer have a single lever.

e Back Table: keeps cutting mat supported horizontally Each pinch wheel has its own
lever to raise and lower.

1.07 Accessories

e Go to Chapter 4 for details on using the engraving and scoring tools.

1.07.1 Assembling the Skycut Stand (optional)

¢ If you purchased the optional stand, please refer to this ) for detailed instructions on assembling the

stand and mounting the cutter onto it.

1.07.2 Tables

e The following instructions are for the original table design. If the tables you purchase have brackets that are
)

not part of the table, please watch this video: \‘

e While the two tables attach onto the cutter and do not require any support, you may prefer to not use them,
especially if you are only cutting rolled materials. However, if you are using the cutting mat, the support they
provide will keep the mat horizontal, thus reducing the chance of the mat drooping and causing materials to
separate from the adhesive on the mat.

e The screws required for attaching are already installed in the Skycut. They will be removed and then, after
aligning the holes in the table, replaced to securely attach the table.

e |t's much easier to install if you have a second person available to hold the tables in place while the screws
are being inserted. It is also helpful to have a flashlight shining on the inside of the tables to better see the
holes for alignment.

e The two tables are identical. Start with either the front or the back of the cutter.

e There are a number of screws mounted on the inside of the end caps. The ones to be removed are the
second and third from the bottom. They are also the only two with washers:

Remove these two screws
from right-side end cap



https://drive.google.com/file/d/16i2e6_f3XqVNit3-Vl9VZ6aDiJ2CL4sw/view?usp=sharing
https://vimeo.com/376972057

Remove these two screws
from left-side end cap

e Align the holes in the sides of the table with the holes in the end caps. Note in the following photos how the
flat part of the table is on the outside:

Flat part is on the outside

These are the screws that are
inserted through the holes in the
table and into the end caps

Right side Left side

e Insert the screws previously removed through the aligned holes and screw back into place. Then repeat on
the other side of the cutter.

1.07.3 Test Pen

e The test pen should be used until you are comfortable with the operation of your Skycut and know, with
certainty, where images will cut. The test pen should arrive pre-assembled. However, if you want to change
out the insert to the red ink insert, note how the test pen is assembled:

-_—-— -

Spring goes over the top of the pen insert
and stops at a small ridge on the insert

1.07.4 Skycut Blades

e There are three kinds of blades that fit inside the Skycut blade holder:

S 8L
d u

Blue Yellow
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O The 45° red capped blade is suited for cutting thinner materials such as paper, all cardstock types,
heat transfer vinyl, and wall/auto/decal vinyl.

O The 60° blue capped blade is a much longer blade and is well-suited for cutting thicker materials, such
as gum paste, craft plastic, craft foam, and rhinestone template material.

O Sold separately is the 30° capped blade. It is a wide blade and is well suited for cutting fabric,
felt, and tint. It has been reported that it also works well with cardstock that has been exposed to
humidity.

Note that the red capped blade and blue capped blade have a cutback on the opposing side of the blade
(right side, in the earlier photo). This reduces the blade offset value and allows for better detailed cutting of
small shapes.

Additionally, there are other tools sold separately, including a stand, an engraving tool and a
creasing/scoring tool. Details on the engraving tool and creasing tool are covered in Chapter 4.

1.07.5 Blade Installation

The blade must be carefully inserted into the blade holder. Do this over a soft surface (e.g., over a hand
towel). It's important to protect the fragile blade! To install, follow the numbered steps as shown:

3. Turn the brass ring 5. Turn the brass ring clockwise
counterclockwise until until locked back in place.
loosened.
2. Gently insert non-sharp end
of the blade into the holder.
An internal magnet will pull 1. Push in this button
the blade inwards. and hold so that a blade
— (— s, can be inserted OR
Then release button on top of - ' e «— removed.
holder T ——

4. Turn the large ring clockwise or counter
clockwise to set blade length to match the
thickness of the material being cut.

The Blade Length (also called Blade Exposure) is how much blade is exposed at the bottom of the blade
holder. For optimal cutting, you want this length to match the thickness of the material or be just a tiny bit
longer.

When setting the blade length (Step 4 in the prior photo), hold the blade holder up next to the material
before pressing the material to the mat, so that you can more accurately set the length to match the
thickness of the material. For really thin materials, like vinyl and thin paper, just the very tip of the blade will
be protruding from the bottom of the blade holder. In fact, you should just barely be able to feel it with your
fingertip and not be able to see it very well, if at all. Having the blade fully extended will never result in better
cutting. In fact, it can cause skewing, tearing of the material, damage to the blade, and damage to the mat
or cutting strip.

A good way to test your blade length is to fold a piece of the material onto itself and then cut a line into the
material by hand. Press firmly but not too hard as more force will not determine if the blade is set to the right
length. If the blade cannot cut through the material, you will need to extend the blade. If the blade cuts
through the material and cuts into the next layer, you need to retract the blade. If the blade cuts through the
material but does not cut into the layer below, you have the perfect length.
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Material

w AT 1T T
A

Perfect Length Too Long Too Short

When conducting a test cut, be sure to check your mat (or the top of a backing sheet) for cut lines after the
test. You should be able to set the length to get clean cuts but with only fine lines or no lines in the mat or
backing sheet. If you do see deep cut lines, retract the blade length ~¥4 of a turn counterclockwise. Repeat
your test cut.

1.08 Preparing and Caring for the Cutting Mat

1.08.1 Tips on Using the Cutting Mat

Always use a mat to hold the material to be cut unless the material has its own protective backing. For
example, vinyl and iron-on transfer both come with a layer that you do not cut. Thus, this backing layer
serves as the carrier for cutting. Paper and cardstock do not have a backing, thus they must be cut on the
mat.

IMPORTANT! A new mat may be too sticky if you are cutting certain products. This can cause difficulty in
removing cut items without tearing. Place an old but clean bath towel over the surface of the mat and press
with a brayer or rolling pin. Then pull up. Test the stickiness by pressing the palm of your hand in the middle
of the mat and lifting. If the mat remains stuck to your hand, repeat until the mat can still be lifted but will
release. It should only take a few pressings to greatly reduce the stickiness as tiny (too small to be visible)
fibers from the towel are added to the surface.

Do not leave the pinch wheels in a down position when the Skycut isn’t in use. This warps the plastic
sooner, shortening the useful life of the cutting mat.

1.08.2 Cleaning and Replenishing the Cutting Mat

When mats begin to lose their stickiness, they can be washed:

¢ Use a mild dishwashing detergent, warm water, and a soft brush to thoroughly clean the surface. You're
not trying to scrub the adhesive but just wet the invisible fibers that have been deposited from your
cutting materials and get them released from the glue.

o Rinse well, shake off excess water, and place sticky side down onto a bath towel.

o Thoroughly dry the non-sticky side of the mat with another towel.

o Pull the mat up and the sticky side should now be dry enough for immediate use. Test by making
sure the mat will stick to your hand.

While washing with soap and water should revive the original adhesive, you can add more adhesive if
necessary:

¢ Virtually any repositionable adhesive may be used on the cutting mat. Some of the popular choices
include: Krylon Easy Tack, Aleene's Tack It Over and Over, Crafter's Companion Stick and Spray, Zig 2
Way Glue with wide tip, Craft Smart Off ‘N On, and Scotch Repositionable Craft Stick. There’s another
spray adhesive, Scotch Super 77, which does not leave a sticky surface but is excellent for stabilizing
paper and cardstock.

¢ If you are cutting thicker materials, such as oil board or styrene, you may want to experiment with a
stronger adhesive and use painter’s tape to secure the material to the mat. If you are cutting thin paper,
then you may want to experiment with a lighter adhesive.
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¢ With most repositionable adhesives, you can control the tackiness based on the amount applied. Thus,
always add a little bit at a time. As mentioned above, if you add too much, just apply a layer or two of
cotton fibers by pressing with a bath towel.

e  Other reported methods for cleaning mats:

¢ Use a plastic scraper (an old credit card will suffice) to scrape off any random material pieces remaining
on the mat after a cut.

¢ For finer particles of paper or lint, you can use a lint roller. Tear off a sheet and then press down and pull
up across the surface of the mat to clean in sections. Baby wipes can accomplish the same task.

¢  To completely remove adhesive from the mat, apply Goo Gone, Duck Adhesive Remover, or Avon’s Skin
So Soft Bath Oil across the surface. Allow a minute to soak in and then scrape off with a sharp metal
spatula. Repeat, as necessary until the mat is thoroughly clean and no longer sticky. Wash, dry and then
add any repositionable adhesive.

e When necessary, the rubber wheels and the grit shafts may be cleaned with isopropyl alcohol or Un-Du.
Apply the cleaner to a clean lint-free rag and rub the entire wheel and/or grit shaft until free of adhesive.

1.09 Pinch Wheels

1.09.1 Raising and Lowering

e The pinch wheels can be raised (for loading the material and/or mat) and lowered (for cutting). Depending
on when your Skycut was manufactured, the method for this is different.

Newer Model Pinch Wheels

e |f you do NOT have a single pinch lever, press down on an individual lever on a pinch wheel so that it can
grip the mat or material. Lift up an individual lever to raise that pinch wheel.

Pinch wheel is in
the up position.

Pinch wheel is in

«—  the down position.

Older Model Pinch Wheels

e If you have a single pinch lever located at the back-right side of the machine, press down on that lever and
the pinch wheels will be raised. Pull the lever up to lower all pinch wheels so that they can grip the mat or
the material inserted into the cutter. IMPORTANT: Always hold the lever while raising and lowering. Never
allow the lever to pop up on its own as this can put a lot of stress on the two couplers gripping the pinch
wheel bar in the back.

e On the single pinch wheel lever models only, there is also a small black lever on each individual pinch
wheel. When the lever is raised, there is more downward pressure exerted. IMPORTANT: Only push these
small levers up when an extra tight grip is needed, such as when cutting reflective film or thick chipboard.
For normal cutting of most materials, it will not be required.
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Lever is in down
position. This is
recommended for

! Lever is in up position. Do
most cutting.

NOT use this position except

with certain materials.
Note: These two photos

ONLY apply to the single
pinch wheel lever model.

RN

1.09.2 Pinch Wheel Locations

Note that for a pinch wheel to grip properly, it must be positioned over a grit shaft. To facilitate alignment,

note the white rectangles positioned along the horizontal bar behind the blade carriage. Slide the pinch
wheels along the bar, as needed:

Wheels should be centered over grit
shafts which are directly below the
white rectangles

When using the cutting mat, it is recommended that the material be placed in the middle of the mat and the
mat placed roughly in the middle of the cutter. Then use the second and fourth pinch wheel locations for

two pinch wheels. This keeps the pinch wheels off the material and provides an equal balance while the mat
moves in and out during cutting:

- ~,—7'

Middle two pinch wheels
are placed under 2™
and 4" white rectangles

Pinch wheels are approx. the
same distance from the
outside edges of the cutting
mat

o Note that if your material is very wide, then it is fine to have the pinch wheels over the material. However,

you may need to be extra careful when removing any cut shapes or waste material in those locations.

1.10 Control Panel

¢ When you first turn power on the Skycut, after several seconds, the following Main Screen or Home
Screen will be displayed:
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Repeat last cut

Change settings
Refer to 1.10.1

Stop and cancel the
current cut

4 arrow keys for moving the
head left/right and for moving
the pinch rollers

. While cutting, this icon and function changes to Pause. m

Open and cut PLT files from an
inserted USB flash drive

@ o

ReCut UsSB

© @&

Speed/Force

Set

Set the desired speed and force.

¥

Test

Execute a test cut using current

St >
8 speed and force settings

Toggle the speed for moving the head and
pinch rollers. In slow mode, the icon

changes to:

Throughout this manual, the functions above will be referenced along with submenus and additional

screens. You will also see the following icons at the bottom of many screens. Pressing the one on the left
will always return you to the Main Screen above. Pressing the one on the right will return you to the prior

window/screen.

Go back to Main
Screen/Home Screen

1.10.1 Set Screen

—

o

<+— Go back to prior screen

e Pressing the Set icon E opens the Set Screen which contains access to many functions and settings.
Note the general description and section number (if you wish to learn more about that function now):

Calibrate and use camera for print
and cut applications: Chapter 3

Set end-of-cut options: Section
2.06

—

Settings for: LED, Units,
Language, Screensaver, Alarm:
Section 1.14.2

—

set
—>

Camera

Wili
E Advance mode

Advanced sellings

&
. ‘ Set up wireless connection to home
or office network: Section 1.12.2
toend >
Array setup, Scale, and options for

* <4— display and cutter behavior: Section
[ 1.14.2

. 4— Version numbers, software
selection, reset: Section 1.14.3

1.11 Reqistering and Installing SignMaster
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1.11.1 Installing from a Download

e Once you have purchased a registration for SignMaster, the software can be downloaded from the following
link. It's important to use this link so that the Skycut will be installed as the cutter of choice. You will need
your Product Serial Number that was sent to you. Since you’ll also need this number every time you
update the software, keep this number in a safe place.

Also use this link to update

https://signmaster.estore.software/downloads your SignMaster software

¢ Note where the file will be saved on your computer so that you can later browse to that folder and launch the
.exe file which has been downloaded. Follow the steps in the following Section 1.11.2, starting with Step

(4).

1.11.2 Installing from a CD

(1) Remove the CD from the case and insert into the CD ROM drive on your computer.
(2) The downloaded file is in.exe format, thus ready to launch.

(3) If Windows Autorun does not initiate a welcome screen, use Explorer to locate and click on the DVD drive
letter for your computer. Double click on the Welcome file and the following window will open:

L et gt X
s sortware ' N

Click on Install Software
\ 4
= g

Install Software

SignMaster.Software

(4) Click on Install Software and wait for the installation program to open. Select the language you prefer:
Select Setup Language X

F—#  Select the language to use during the
k ‘fJ instalation:

Select preferred language
and click on OK I— = v

(5) Read and accept the license agreement:

Setup - SignMaster - *

License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

A FUTURE CORPORATION PTY.LTD. ~
SOFTWARE LICENSE AGREEMENT

I. IMPORTANT: THIS IS A LICENSE, NOT A SALE. PLEASE READ THE TERMS
AND CONDITIONS OF THIS SOFTWARE LICENSE AGREEMENT CAREFULLY
BEFORE USING THE SOFTWARE (HEREAFTER “AGREEMENT"). BY SELECTING
THE “I ACCEPT THE AGREEMENT" OR “AGREE" OPTION(S) AND
CLICKING *NEXT", OR OTHERWISE INDICATING ASSENT ELECTRONICALLY, OR
INSTALLING THE SOFTWARE, ¥ 0Ol ACCEPT AND AGREE TO BE BOUND BY AND v

Read the agreement, click @®1accept the agreement
on the accept Option and (1 do not accept the agreement

click on Next
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(6) Enter the Product Serial Number which should have been sent to you by email when you purchased
SignMaster. Note that since you will need this same number any time you update the software, keep it in a
safe place:

Jol Setup - SignMaster — *

Product Information
Enter Product Serial Number (PSN).

Pleaze enter your Product Serial Mumber and dick Next to continue.

Enter the 20-d|g|t PSN Product Serial Number (PSN):
provided when you ]
purchased SignMaster

and click on Next

(7) Read and accept a second license agreement and then verify the destination for installing SignMaster:

|54 Setup - SignMaster — ®
Select Destination Location
Where should SignMaster be installed?

Setup will install SignMaster into the following folder.

To continue, dick Mext. If you would like to select a different folder, dick Browse.

Browse...

Note where the program /V
will be installed and click

on Next

At least 143.9 MB of free disk space is required.

(8) Select your preferred Units but note that it can easily be switched once the software is open:

[5d Setup - SignMaster - X

Default Units
Select Default Units

Please select the units (measuring system) you would like to use

(®) Metric (mm)
Select preferred Units —7 Om=tm
and click on Next
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(9) Select SKYCUT V24 (or the model you have purchased) from the drop-down menu:

Setup - SignMaster — *

Install Cutter Driver
Choose a Cutter to automatically install the driver.

Select your Cutter Model. ..

SKYCUT ¥24 2%

Select SKYCUT D24 (or
the model you have
purchased) and click on
Next

Install Driver: SKYCUT V24

(10) In the next window, you'll have the option to create a desktop icon and install a thumbnail previewer. Both

are recommended.

Setup - SignMaster - X

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing SignMaster,
then dick Next,

Additional shortcuts:

. X Create a desktop shortcut
Select preferred options and click e e
on Next Other tasks:
Install Thumbnail Freviewer

(11) At this point, files will be extracted and installed. Wait for the Installation Complete message and click on

OK:

Setup X
Installation Complete!
SignMaster PRO
Click on OK ————»

(12) Then the final Finish message will appear and you can choose to open SignMaster or wait:
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ﬁ' Setup - SignMaster -

Completing the SignMaster Setup
Wizard

Setup has finished installing SignMaster on your computer, The
application may be launched by selecting the installed
shortouts,

i . Click Finish to exit Setup.
Leave checked if you wish to

open SignMaster now Launch Sgister

\C

Click on Finish >

If you run into any issues installing or activating the program, please visit this link:

http://www.iifuture.net/fag/index.php?action=show&cat=44

You may wish to periodically visit the link provided for SignMaster at the beginning of Section 1.11.1 to
download and install any new updates.

1.12 Connecting the Skycut to Your Computer

e Place your Skycut on a sturdy horizontal surface. If using the cutting mat, be sure to allow enough free room
in both the front and the back for the mat to extend during cutting.

e Powering On:

¢ Plug the power cord into a wall outlet or power strip. Connect the power cord to the Skycut V on the left
side end cap.

¢ Turn on the power using the power button that is also on the left side end cap. After several seconds,
the light inside the Skycut will turn on and the head will do a slight jog.

e You have four options for sending files and information from your computer to the Skycut:

¢ Direct USB using the included USB cable

¢ Wi-Fi — adding the Skycut to a home/office network that is also accessed by your computer

¢ Wireless Standalone — connecting wirelessly to your computer

¢ Review the information in the following table to understand the differences between these options. Note that
implementing any of these options does not preclude you from changing to another one, as needed.
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Connection Options for the Skycut with SignMaster Pro

to the computer; Cannot be
accessed by other computers
atthe same tme

Some routers may require
setiing changes in order to
work with the Skycut

the Skycut, thus no wireless
access to the Internetor to
other wireless devices

Option us Wireless to Network (Wi-Fi) Wireless Stand-Alone USB Flash Drive
Descripton | The Skycutis connected fo the |The Skycutis wirelessly The Skycutis wirelessly Files are saved in PLT format
computer via a USB cable connected to a network router [connected to the computer. from SignMaster to a USB flash
drive
Requirements |USB cable (included) Wireless network router and Computer must have wireless |USB flash drive
knowledge of router's name capability
and password
Pros Easy fo install; Reliable and fast|Skycut can be located Skycut can be located Skycut can be located
form of communication. anywhere within range ofthe  [anywhere within range ofthe  |anywhere
router; Other computers can cut|computer; Other computers can
to the Skycut cutto the Skycut
Cons Skycutis physically connected [Requires more steps to setup; |Computer is now connected to |More steps due to saving and

then loading the file; Cannot
adjust size and certain cut
setiings once saved

connectivity issues, please contact your dealer.

1.12.1 USB Connection

Plug the small square end of the USB cable into the right end cap of the Skycut V. Plug the USB end into an

available USB port on your computer.

In SignMaster, click on the Cut, Plot & Engrave Tools icon

-

The following sections present what steps are required for each type of connection. If you run into

(6" from the left on the upper middle
task bar) and select Vinyl Spooler. In the window which opens, click on the Connection tab.

Verify that Skycut V24 is selected under Current Cutter. If not, select it from the drop-down menu. Under

Port Type, select Direct USB Port. In the drop-down menu next to USB Port, select an option that contains
the word “skycut”:
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¥ Preview % Cut Options o Connection T Calibration
Current Vinyl Cutter (Plotter)

T Current Cutter |5KYCUT:V24 v|
Should read SKYCUT /

V24 (or the model you Direct USB Remove - Add
have purchased)

Select Direct USB

Connection Method / Port
I(_‘\

Port Type | § Direct USB Port v‘ \2) Help
Settings
e — Look for and select an
§ UsBPort ¥id_aeiapid_a/a0sskycut_dbsc D option with “skycut” in
the name
Status Device Connected
Mest Area Test Cut Nov Done 4«— Click on Done

e |f a USB Port option cannot be located, verify the connection at both the cutter and on the computer. Once
connected, proceed to Section 1.13.

1.12.2 Wi-Fi Connection  Vide0

¢ Note: Not all routers have the same signal strength. It's usually best to connect the Skycut while it is in the
same room with the router. Once connectivity is established, you can then experiment to see how far from
the router the Skycut can be located.

e What you'll need:
¢ Name of your home/office network

¢ The password for your network

e Carefully complete the following steps:

(1) On the Skycut’s control panel, select Set m and then select Wifi. The Wifi screen will appear:
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set
Click on Wifi | Camera 5
I Wifi > |
Advance mode toend > .
Advanced setlings >
B General sellings 5 |
% Sys Informalion ¥

1

SSID: Click on Scan

(scan for home/office network) -
PassWord:

(setyour network password) -

IP Address Sel :

long press key 3 seconds :

| et
@ e

(2) Click on the Scan button and a list of the available networks will appear. Select your home/office
network and click on Apply. You will then be returned to the Wifi screen:

Select your

network
\

DIRECT - D5 - HP Offlice)et Pro 8720

Sam and Cloria

Skalka

DIRECT - U T200 Z5ANDYHP rasl 37

Click on Apply

(3) Click on Set and the following screen will open:

15450
Password will —

display here

Switch to punctuation

Toggle to switch between
uppercase and
lowercase letters

Click OK when done

SSID:

NITGEAR13 [Scan
PassWord:

(setyour network password) -

IP Address Sel :

Click on Set

long press key 3 seconds :

| De |
&

WXYZ

Switch to
numbers

Delete last
character
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(4) To enter the password, use the following tips if you are unfamiliar with this type of screen:

¢ “Rapid tap” multiple times in succession to select a letter. For example, if your network password is
cts456, then to enter “c”, you would tap three times on “abc” because “c” is the third letter in “abc”.
Next you would proceed to “stu” and tap two times to enter “t”. Then you would only need to tap on
“stu” once to enter the letter “s.”

O To enter numbers, click on “123” to open the number entry screen.
O For punctuation, click on “#@~" to open the extra characters screen.

O To enter upper case letters, click on the up arrow in the lower left part of the screen.

(5) Once you have the password entered in the display box at the top, click on OK to return to the Wifi
screen:

SSID:
s
PassWord:
Default P Address e
assigned to Skycut

Click on “+” or “-“ buttons to
£ Address Set.: change IP Address, if needed

- xxnANxxxx.200

long press key 3 seconds :

| Debut |
@ E

(6) Next check the IP Address that will be assigned to the Skycut. The Skycut will automatically pick up the
first three sets of digits from your router but will continue to display them as shown above. You only
need to decide if the last set, which should be defaulting to “200”, can be used. Use the “+” or “-“ buttons
to make any needed changes.

(7) Click on Apply and wait for several minutes while your router assigns this IP Address to the Skycut.
Eventually, you will see Connected OK appear and your full IP Address will appear in the orange strip

at the top: . .
P Network name Write down this

\ IP Address
f_‘ﬁ
k4

SSID:

-
PassWord:

-

IP Address Set :

= T =

SSID:
NITGEAR1S Sean.
PassWord:
ctsdh6

SSID:
NETGEAR13 [Scan
PassWord:

ctsd56

IP Address Sel :
- xNANKxxx.200 - ‘

long press key 3 seconds :

IP Address Sel :

- AXNANKXxx.200

long press key 3 seconds :

long press key 3 seconds :

et
@ =

Click on Apply Wait will be displayed for Success!
several minutes

o

o

(8) If instead of receiving a Connected OK display, you see Password err, again verify the network you
selected and the password you entered. If it continues to fail to connect, confirm the IP Address you
entered. Additional troubleshooting for Wi-Fi connections can be found in Appendix Al.

(9) If you wish to reset and start again, press and hold the Default button for 3 seconds until the button
turns red. Then click on Scan and repeat from Step 3.
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e Once you receive the Connected OK display, in SignMaster, click on the Cut, Plot & Engrave Tools icon

’ (6™ from the left on the upper middle task bar) and select Vinyl Spooler. In the window which
opens, verify that Skycut V24 is selected under Current Cutter. If not, select it from the drop-down menu.
Under Port Type, select Windows Port. Mark the option for Port and select TCP from the drop-down

menu:
@ Preview T' Cut Options lt‘ Connection U Calibration
Current Vinyl Cutter (Plotter)
TF Current Cutter |5KYCUT: Vi4 w
/ TCP Remove + Add o ]
Should read Select Windows
SKYCUT V24 (or the ~ Connection Method Port
model you have
purchased) Port Type |l 5 Windows Port w () Help
Select TCP
Settings
Select Port %’L t @ Port éTCP & o Configure <4t— CI|Ck on
Configure

192.168.16.254 / Port 3080
= () Printer

e Click on Configure and the following window opens:
TCP/IP Port ®
Settings

Default IP Address IP Address

| ‘susu “ ‘ Test

o

e Change the IP Address to the one you set up on the Skycut control panel. Click on Test. A Port OK
message should pop up. Click on OK and then click on Apply:

TCP/IP Port W
Settings | )
Change to IP Click on Test
Address from IP Address Port

Information x

o Paort OK

control panel /
\‘wzﬂﬁﬂ.tlﬁﬁi | |E~C'EE' v‘ Test ‘
|

Apply Cancel

Click OK

Click on Apply
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The IP Address should now appear in the Vinyl Spooler window:

Settings
IP Address should = @Port = ¥ (InEIE
now be here T > 192.168.1.200:3080

& (O Printer

Mest Cut Mow Done < —m8M8M Click on Done

Click on Done and proceed to Section 1.13.

1.12.3 Wireless Stand-Alone

>

It's usually best to connect the Skycut while it is next to the wireless computer. Once connectivity is
established, you can then experiment to see how far from the computer the Skycut can be located.

There are two situations to consider before getting started. If you are not sure which applies to your Skycut,
then select B and go to that section first.

A. The Skycut has never been set up wirelessly to a network.

B. The Skycut has previously been connected to a wireless network.

The Skycut has never been set up wirelessly to a network

Power on the Skycut and wait for the light to come on.

On your computer, open your list of available networks. In the list, you should see one with this type of name
format: HI_LINK_XXXX where “XXXX” can be any alphanumeric combination, such as “92BF” or “08A5”.

Select that network and enter the following Network Key when prompted: 12345678.

-

In SignMaster, click on the Cut, Plot & Engrave Tools icon (6" from the left on the upper middle
task bar) and select Vinyl Spooler. Inthe window which opens, verify that Skycut V24 is selected under
Current Cutter. If not, select it from the drop-down menu. Under Port Type, select Windows Port. Mark
the option for Port and choose TCP from the drop-down menu:
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@ preview T Cut Options 5 Connection [ calibration

Current Vinyl Cutter (Plotter)

TF current Cutter |5KYCUT:V24 v|
TCP Remove + Add o
lect Window
Should read Connection Method ﬁgretCt dows
SKYCUT V24 (or the /
model you have Port Type 4 Windows Port v‘ (@ Help
purchased)
Select TCP
Settings
Select Port ———pe @ Port Tcp A i Configure @ Click on
192.168.16.254 / Port 8080 Configure
= () Printer

Check to see if this is
already set

In the prior screenshot, the IP Address is already set to the correct Stand-Alone IP Address:
192.168.16.254. If this matches what you see, skip the next two steps. Otherwise, click on Configure and
the following window opens:

TCP/IP Port >

Settings

Enter the following

B 1192.168.16.254

‘ |E”G'E”{II V| st 4«——— Click on Test

Apply Cancel

Change the IP Address to 192.168.16.254. Click on Test. A Port OK message should pop up. Click on OK
and then click on Apply:

TCP/IP Port X
Settings
IP Address Port
Information *
192.168.16.254) ||aos0 | Test
) Q-
Apply Cancel

Y

. Click OK
Click on Apply

The IP Address should now appear in the Vinyl Spooler window. Click on Done and proceed to Section
1.13. Remember that your computer will not have access to the Internet or other network devices while in
Wireless Stand-alone mode.
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B. The Skycut has previously been connected to a network

¢ On the Skycut’s control panel, select Set E and then select Wifi. The Wifi screen will appear:

set

SSID:
=
Click on Wifi Camera ¥
PassWord:
(@ | E——

(set your network password)

E Advance mode toend ‘ IP Address Sel:

Advanced sellings
B General sellings

E Sys Informalion

long press key 3 seconds :
Press and hold
- Default

e Toreset the Skycut so that it will be found as an available network, press and hold the Default button for 3
seconds. Release and you should see the Apply button now displays Wait. In a minute the Apply should
return and you can then proceed back to A. The Skycut has never been set up wirelessly to a network and
use the same procedure as if the Skycut was never set up on a network.

1.12.4 USB Flash Drive  Video

e With a USB Flash Drive connection, you will normally follow the steps presented in this section. If you are
new to SignMaster and/or to your Skycut, it is recommended that you go to Section 1.13 now to learn how to
insert the mat and test pen, adjust settings on the control panel, and set up a test design. Then, when you
are ready to cut, return to this section.

e Design or open a file in SignMaster. After making any changes to the design, click on the Cut, Plot &

-

Engrave Tools icon (6™ from the left on the upper middle task bar) and select Send to Cutter. The
following window opens:

Click on Properties to open Vinyl Spooler window
Send to be Cut *®

General  Cutter Control Settings Tiling/Panels

I ® €
Vinyl Cutter (Plotter)
Select Model ‘SKYCUT: V24 v ‘ Properties
Quantity
Job Name ‘Untilled ‘ 1 [E]
SKYCUT: V24, 24.803 in
[ rotate [] Advance After Piot Il Black Color (1/1)
] mirrar [[] Absalute (position) Preview of
where shape
General Options "~ W|" be draWn
[[] separate by Color or cut
[[] Registration Marks [ Assign Tooks by Color
c
) w
v =
oY
[] Auto Speed-Weed [ Auto Weed-Box | |
6.052 in

e Click on the Properties button to open the Vinyl Spooler window. The Cut Options tab should
automatically be selected. Verify that the Pen Tool is selected (assuming this is your first time testing your
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Skycut). Also verify that the force and speed settings are not marked. At the current time, it is
recommended that you always do these settings on the Skycut’s control panel, instead:

Sele.Ct Cut ——— 3 Frdpic r Cut Options .5 Connection & calibration
Options tab
TF SKYCUT: V24
Media Size
Media Width 24.803 in = edia
Media Length 0.000 in =
[J Cut in Strips
Cutting Options
. Preset Mode: ~ Edit Presets
Pen drawing:
leave unchecked;
I L 35 = Calibrate
Cutting: Check [ Biade Offset 5 s ¥ Calibrate
and enter settings 1.00 2
Blade type Pen Tool y Pen drawing: select Pen Tool
< Cutting: select blade type from
. . menu
Additional Options
Tool Select Default ~ | Primary
Uncheck all [] cutting Force 50 =18
three of these [ Cutting Speed 250 =
settings [] Travel Speed (5) |250 =15
Cutting Opticns
DMvance after plot Area Tests
Mest Area Test Cut Moy pone <4——— Click on Done

IMPORTANT: For initial testing of your Skycut, it is highly recommended that the test pen be used until you
know, with certainty, where shapes will draw.

Click on the Connection tab and verify that Skycut V24 is selected under Current Cutter. If not, select it
from the drop-down menu. Under Port Type, select Windows Port. Mark the option for Port and then
select U_Disk from the drop-down menu:

Select Connection tab ~®—freview—§curoptiond®> 5 Connection T calibration

Current Vinyl Cutter (Plotter)

TF Current Cutter |5|‘\'YCUT=‘\"24 v|
U_Disk; Remave + Add P

Should read SKYCUT Select Windows
V24 (OI’ the model you Connection Method Port
have purchased) Fort Type (5 windows port <] & help

Settings

Select U_Disk
Select Port T @Port U_Disk v &——mmm -
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Click on Done at the bottom of the Vinyl Spooler window and you will be returned to the Send to be Cut

window. More about the settings on the left side of the window will be covered in Section 2.03. For now, just
note where your shape will draw relative to the material and how to initiate the exporting of the PLT file:

General Cutter Control Settings Tiling/Panels

—— o e

Vinyl Cutter (Plotter)
Select Model [skveuT: vas | [ Properties |
Media Width 24803 in =
Quantity
Job Name ‘Unhlten | |1 ﬂ‘
[rotate [ Advance After Plot
[ Mirror [] Absolute (position)

General Options
[Jseparate by Color

[] Registration Marks [ Assign Toals by Color

[ Aute Speed-Weed [ Auto Weed-Bax

Text Options
[[] Easy-Lift Weed Marks
[ weld Text

[ speed-Weed Text Only

Note where the
design will draw
relative to where the
test pen is positioned

SKYCUT: V24, 24.803 in
Il 5iack Color (171

< This figure assumes
— 3 blade holder is positioned
in the lower right corner of
e the material
Area Test Cut Now Spool All Cancel

e Insert a USB flash drive into your computer and allow Windows to find it. Note the drive letter assigned by
Windows.
e Click on Cut Now and a Save PLT File window opens because earlier you had changed the connection
type to U_Disk. Browse to locate the USB flash drive you plan to use and name your PLT file:
# SavePltFile X
Savein: | u USE DISK(E) v @@ =M
Locate the USB flash ~—— =" | : - | o - =
drive for saving your files + Name Date modified Type
) System Velume Information 7/18/2014 8:52 AM  Filefolder
Quick access [ 1 inch Circleplt 6/28/2013 207PM  PLT File
| 11 inch Ring Test Shape.plt 6/28/2018 208 PM  PLT File
- || Favorite Flourish.plt 6/28/2018 207 PM  PLT File
Desktop | ] Favorite Flower.plt 6/28/2018 2:09PM  PLT File
| ] Owl PNC.plt 6/28/2018 2:24 PM PLT File
| | State of Arizona.plt 6/28/2018 2:08 PM PLT File
Libraries | | Test Calibration.plt 6/21/2018 £12 PM PLT File
i || Test of Qrigin Point.plt 6/28/2018 206 PM  PLT File
I@ || Test Settings.plt 6/13/2018 1:30 PM PLT File
This PC
L .
Network ’ Click on Save
Enter a file name ————p fename | WD o e
Save astype: Pit File (".plt) w Cancel
e After saving the file, eject the flash drive and insert it into the right side of the Skycut. On the control panel,

select USB and then Open File:
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4— Press Open File

¢ Set up repeats, refer to
- Section 1.14.1

(1) Double tap on USB DISK and a screen will open showing any folders and PLT files on the flash drive.
Double tap a folder to open it, as needed. Drag the scroll bar on the right to see more files:

Double tap here

] System Volume Information

W LmerCircten Drag here to scroll

¥ linchRing Test Shape.plt

)

¥ FavoriteFlower.plt

¥ Favorite Flourish.plt
¥ OwIPNC

¥ Stateof Arizona.plt

l

(2) Once you have located the PLT file you want to cut, double tap the name. You will be taken back to the
USB screen and the selected file name will be displayed:

& Arrow Testplt

) System Volume Information

¥ linchCircleplt
e Double tap on
selected file to go
back to USB screen

¥ OwIPNC
¥ Stateof Arizona.plt Click here and
cutting will begin _

¥ linchRing Test Shape.plt

¥ Favorite Flower.plt

¥ Favorite Flourish.plt
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(3) If you wish to cut repeats of the file, select Array Set and a screen will open where you can then select
the number of rows and columns of repeats, along with the spacing between the repeats. Refer to
Section 1.14.1.

(4) If your project is a print and cut (aka contour cut) application, please refer to Section 3.09.

(5) When you are ready to cut, click on Start Cut.

1.13 Test Draw Shapes

o New owners tend to be VERY eager to try out their Skycut. It's important to test your cutter to ensure that
data is being sent properly from your computer to the cutter. The following steps will allow you to do some
testing with the pen tool. But note that the following steps are for DRAWING, not cutting. Before
inserting the blade holder into your cutter, please read the following Sections 1.07.4, 1.07.5, 2.01, 2.02, and
2.03.

e |tis also very important to understand where shapes will cut based on various available options in
SignMaster. This is partially addressed in the next section; complete details are covered in Section 2.02.2.

e Before setting up a file for testing, if you are new to SignMaster, it is recommended that you watch the
;& >

following introductory video:
¢ You have two options when using the test pen:

¢ Insert a sheet of paper directly into the cutter. Make sure the paper is past the ruler so that it doesn’t
catch when feeding the paper forward:

Observe how pinch
wheels are centered
with white rectangles

¢ Or...Place the paper onto the cutting mat and then insert the cutting mat into the cutter:

Observe how pinch
wheels are centered
with white rectangles
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Feed the mat this
direction into the
Skycut

Only the front part of the
mat and material will be
in the front of the
machine.

Align the paper along
one of the grid lines on
the cutting mat.

Use any of the horizontal markings at the front of the Skycut (such as the ruler) to align the mat so that it's

straight. Lift the pinch lever to drop the pinch wheels onto the cutting mat. Most of the mat and the paper
should now be behind the cutter, not in the front.

Before installing the test pen, make sure the pen will write by scribbling on scrap paper. Note that you will

probably need to remove a tiny bit of wax on the end of the pen nib. Then follow these steps:

¢ Loosen the screw on the blade holder seat.

O Insert the test pen allowing it to freely rest on top of the paper.

¢ Before tightening the front screw, raise the test pen up a little bit (~ 1/8” or several mm). You don’t want
the pen still touching the paper but you also don’t want the pen too high above the paper either.

O  Tighten the front screw to lock in the test pen. Be careful not to push down on the blade holder seat

while tightening.

IMPORTANT! This is NOT the recommended method for loading the blade holder into the cutter.
This is presented as a quick way to insert the test pen so that it is in a good position for drawing.
The instructions for inserting the blade holder will be covered in Section 2.01.3.

e The arrow keys on the Skycut’s control panel will always be used to set the origin for cutting:

Use these arrows to move
the mat in and out and
move the head left and
right

-

Stop Speed/Force

Tesl

The middle button can be
toggled, if needed, so that
the movement is much
slower.

¢ Press the arrows on the control panel to move the head left or right and the mat in and out. The goal is
to have the tip of the pen close to the lower right corner of the paper:
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Feed the mat this
direction into the
Skycut

Move pen tip
to this corner
of the paper.

Move the pen tip
to this corner of
the paper

¢ Once the pen tip is near the lower right corner, you are ready to proceed with the test.

The Force and Speed will also be set using the control panel. Press the Speed/Force button and the
following window opens where you can set the Speed and Force to the settings shown. Note that you can
either press the + and — buttons or you can slide the orange bar with your finger or stylus:

8 (15.6in/s)

FORCE:

Change the Speed to ~ 8

Change the Force to ~30

¢ In SignMaster, on the left side tool panel, press and hold the General Power Shapes icon and, from the
drop-down menu, select the Arrow option:

‘1

Press and hold the @]

General Power Shapes » L8 [ squareRectange

con @ O Circle/Ellipse
S star

— Select Arrow

T CD Rounded Arrow

4

.F_| @ Basic Shapes

=T

e Press and hold the left mouse button and drag the mouse in the Drawing Area to create the arrow shape.
In this test, it doesn’t matter where you place the arrow on SignMaster’s Drawing Area, as it will be drawn
at the origin you set on the machine.
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o |f you wish to resize the arrow, either drag one of the square handles around the selected arrow or, in the
settings above the Drawing Area, change the Width or Height, if desired:

Don x (47550 =l 4+ |4.000in L o o
oo Wi nd Hei
boo y 56780 < T 18120 L dth and Height

— =

e At this point, if you plan to export this file to a USB flash drive, rather than cut directly to the Skycut from
SignMaster, please go to Section 1.12.4 for instructions.

e After making any changes to the design, click on the Cut, Plot & Engrave Tools icon and select
Send to Cutter. The following window opens. More about the settings on the left side of the window will be
covered in Section 2.06. For now, just note where the shape will cut relative to the material:

General Cutter Control Settings Tiling/Panels

—— 0 e
Vinyl Cutter (Plotter)
Select Model [storcu: vaa ] [ properties |
Media Width 24803 in =
Quantity
Job Name |Unlllled | ‘1 ﬂ|

SKYCUTIV2S, 26503 Note where design
[kotate [ Acvance After ot W Bisck Color (171) will cut relative to
where the blade
holder is positioned

[usirror [] Absalute (position)

General Options
[ 5eparate by Color

[[] Registration Marks [ Assign Tools by Color

- Test pen is positioned in

— > 3 :

1 qj* the lower right corner of

[ uto Speec-Weed [ Auto Weed-Box the material before
6052 in drawing
Text Options
[[] Easy-Lift Weed Marks
[ weld Text
[ 5peed- Weed Text Onty ==t
Area Test Cut Now Spool Al Cancel

e Before executing the cut/draw process, the Pen tool will be selected. Click on the Cutter Control tab and
the following settings will be displayed:

Click on the Cutter Control tab Open Blade Settings Library

General Cutter Conlrt*étings

Cutter Settings

) [ elade Offset 0.35 S Passes |1 =
Tool settings J
] Cut holes first Pen Tool

r

+

e Click on the small icon to the left of Passes and the Blade Settings Library opens:
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Blade Settings Library

X ]
Setect Blade Preset |
Description v —_ ‘

,If Blade Type ~

Click down arrow

Blade Offset 0.35 mm Update
Over Cut .00 mm
Apply Cancel

To switch to the test pen, click the down arrow to the right of Description and select Pen Tool:

Description v Description Pen Tool ¥/'| Pen Tool now
U Mo Blade Offset appears here
Blade Type Defauit Blade Blade Type Pen Tool v PP
30 degree blade
45 degree blade
60 degree blade
Pen Tool
Blade Offset Blade Offset 0.00 mm Update
Over Cut Pounce Over Cut 0.00 mm
45 Deg Red Cap
Apply = Apply Car
Select Pen Tool A test pen image appears

Click on Apply and the Cutter Settings (Tool settings) will update showing a 0.00 setting for Blade Offset
(more about this setting is covered in Section 2.03.3):

Send to be Cut

Blade Offset should now read 0.00

General Cutter Control  Settings

Cutter Settings

[] Biade Offset 0.00

[ Cut holes first Pen Tool - Pen Tool Pen Tool should now appear here

Click on Cut Now and a confirmation window opens. Answer Yes to proceed, No to cancel:

Confirm

o Proceed with Cutting?

Yes No

After selecting Yes, the Skycut will draw the arrow on your paper:
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Feed the mat this
direction into the
Skycut

The arrow is drawn at the origin
and points to the right.

To draw again, return to the cut window and choose a different origin. Practice moving the origin to different
locations. If you want to have the arrow draw in a Landscape orientation, then mark the Rotate option. You
will see the arrow rotate in the Preview:

Check Rotate

General Cutter Control |Settings Tiling/Panets

Vinyl Cutter (Flotter)

Select Model

Media Width

Job Mame

General Options

[svcu: vae ~| | Properties
24,803 in B

Quantity
[untitied | |1 ﬂ‘
Rotate [[] Advance After Plot
[ mirrer [] Abselute (position)

[[] Registration Marks

[[] Auto Speed-weed

[[]Separate by Color

[] Assign Tooks by Color

[] Aute Weed-Box

SKYCUT: V24, 24.803 in
Il Siack Color (1/1)

"
»éJ

e

ﬂ o Note arrow is
-

T now rotated

2.846 In

Feed the mat this
direction into the
Skycut

The arrow is drawn at the origin
and points down
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If you want the arrow to draw where you have it located on the Drawing Area in SignMaster’s main screen,
versus at the origin, then you need to mark the option called Absolute (position) in the same Send to be

Cut window:

Location of arrow in
Drawing Area —> ‘

Check Absolute (position)

General Cutter Control Settings Tiling/Pynels

Vinyl Cutter (Plotter)

Select Model [seveum:vas— \ | | Properties
Media Width 24803 in =
Quantity
Job Name ‘ Untitied \ ‘ [1 _:J‘
Rotate [[] Advance After Plot

Mirror Absolute (position)
[[] use Top Left Origin

General Options
[[]Separate by Color

[[] Registration Marks [[] Assign Tools by Color

[] Auto Speed-Weed [] Auto Weed-Box

Arrow will now draw in
this location

SKYCUT: V24, 24.803in
Il G 11

12.544 in

Test pen is still positioned in lower right
corner of material before drawing

Set the origin in the lower right corner of the mat’s grid and then place the paper in the correct location on

the mat to correspond to where the shape is positioned in SignMaster.

details on controlling where images will cut.

Refer to Section 2.02.2 for more

IMPORTANT: Please read Section 2.01 before cutting!

1.14 Additional Control Panel Settings

The Skycut’s control panel offers a number of default settings. Some of these may not be important at this
point in the learning process. So, you may want to skip this section for now but remember that it's here and
could provide you some options to improve your experience with the Skycut.

Each of the following sections will refer to one of the settings in the Set screen.
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1.14.1 Advanced Settings

The optional settings in the Advanced Settings screen are:

——
advanced settings
Set up rows & columns of repeats —{ [ Array @o
Show Point @I 0+4— Display (X,Y) location of cutting
head
Separate Cut Speed from Up —» Up Speed @r o
Speed To rich Turn on if you want cutting head
[ Torightpoweron @O to move to the far right when

Option to change directions on —» Y Key Mode default > cutter is powered on

up/down keys

System Mode

one head > 94— Various command options such

Sizing Calibration —>

Refer to Section 2.08

0

Scale

o

Array: Tap the Array button to open the Array screen:

Array

in
O «EIEN
00 S
e

o

as multiple pass and fast scan

I N

4«— Tap here toturn on Array  © 000

gg% k._. Number of repeats: left to right
E . I:.ll Y:.. Number of repeats: up & down

<— Spacing between left-to-right repeats

<4— Spacing between up-&-down repeats

In the above screenshot, the shape sent to the Skycut would cut 3 copies across and 7 up and down,

for a total of 21 shapes. The spacing between each shape would be 0.20 inches (Note: to use mm
instead of inches, switch the Units setting. Refer to Section 1.14.2).

L]
position of the cutting head:

Show Point: When toggled on, the Main Screen displays movement and location output based on the
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Relative Location

Press here to reset
Relative Location

x=2447in X=0878in
y=1.293in Y=1.943in

I=2.767in L=2.132in

}

' >

Absolute Location

As arrow keys are tapped, all locations
will update

Speed control for arrows buttons is
located here when Show Point is on.
Press to toggle to slow speed when

needed:

¢ Absolute Location displays the current location relative to a “power-on” location of (0,0):

o Xis the left-to-right location

o Y is the up-&-down location

o L is the straight-line distance from (0,0)

¢ Relative location displays the change in location currently being made as you press the arrow keys:

o X is the current left-to-right distance moved from X

o Y is the current up-&-down distance moved from Y

o | is the straight-line distance from the (X,Y) location

At any time, if you press on top of the current location of either XYL or xyl, the blade carriage will return to

its last origin.

To set an origin for cutting that can be returned to after either finishing a cut or stopping a cut, press the

Origin Set button before sending the cut.

Speed/Force

x= 2447 in X=2447in
y=1293 in Y=1293in

= 2767 in [=2.767in

}

e [6)

{ >

—

Short press
Origin Set
button and xyl
is reset

ReCut
=y i
Speed/Farce Tert

x=0.000 in X=2447in
y=0000in  Y=1293in

I= 0000 in L=2767in

}

‘@-

l >

After the cut, you can move the mat or material (using the arrows keys on the control panel) to check

the quality of the cut. If needed, you can then press on top of the xyl displayed location (i.e., the
Secondary Location) to return the blade carriage to its Secondary Origin. Then press Re-Cut on the

control panel to repeat that same cut.

This feature can also be useful for production processes, such as repeating the same Print+Cut.
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Up Speed is how fast the blade travels while in the “up” position, such as when it is moving from the origin
to the location of the first shape to cut or when moving from one cut shape to begin cutting another. When
turned off, Up Speed will match the SPEED set for cutting. Turning on this setting will change the
Speed/Force screen to display both speeds, allowing them to have different settings:

Cut and Up
Speed SPEED:. 7(13.6in/s) Up Speed UP SPEED: 12(23.6in/s)

. - . Cut Speed CUT SPEED: 9(12.6in/s)

FORCE:

70
i —

=

| }

~

)

l--

To right power on: With this setting turned on, the cutting head will move to the far right whenever the
Skycut is powered on.

Y Key Mode: This setting controls the movement of the material or cutting mat when using the up and down

arrows in the Main Screen:

Pressing an UP arrow will move Y key mode

the material forward delut Pressing an UP arrow will move the

material towards the back of the

Pressing a DOWN arrow will Reverse cutter

move material towards the back
of the cutter

Pressing a DOWN arrow will move
material forward

System Mode has the following options:
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|
System Mode

Set to one head ———,| onehead v

double
Does not apply to V model

Fast Scan Mark

When enabled, camera will
only take one photo at each
registration mark

Activate command: refer to
Appendix B

e Scale is used is used to input the sizing calibration. Refer to Section 2.08.

1.14.2 General Settings

e The optional settings in the General Settings screen are:

General sellings
Set preferred lighting intensity —»f 73 (1D set

Screen and alarm 90min - 4— Select blackout time for
. screens and end-of-cut alarm

Select inches or millimeters —» @ Unil in >

m Language 4_ Select preferred language for
- control panel

@ =

e LED set allows you to change the brightness of the light inside the Skycut or even turn it off:

Drag to change the intensity
of the light

Turn off light
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e Screen and alarm has two settings:
¢ Screensaver time: Set a black-out time, in minutes, for the control panel

¢ Alarm after finish working: When a job is complete, have an alarm sound (five beeps)

Sereensaver lime (Min):

15
Decrease Screensaver time __ . - . <« Increase Screensaver time (or
(or drag the orange bar) drag the orange bar)
Turn on Alarm to beep at end of
cut

Alarm after finish working

e Unit allows you to choose either inches or mm for settings such as Show Point and the Spacing setting

under Array.

e Language allows you to choose from multiple languages to be used throughout the control panel display

screens:
Language

| &3

2 English v
3 Caslellano

4 Dansk

5 Magyar

& Turkish

7 Porluguese

8 Russian

1.14.3 Sys Information

The Sys Information screen displays information about the Skycut and only has three setting changes
available:
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MODE : V24_V48

Model ID's and ) HVER : V7.1202
odel ID’s and version S
numbers
MPID : 92A2-672D-ECES-BB47 d hold
SOFT : SignMaster/SCAL Press and hold to open
. Software Screen
BAUD setting based on BAUD : 57600-L
software selected ERR: 0

STA: m |

long press key 3 seconds !

- Press and hold to reset Skycut

¢ This initial screen displays current version numbers.

¢ If you ever need to reset your Skycut, press and hold Default All until it turns red. Then wait for the

button to update to Success!

¢ If you ever need to change which software is in use with your Skycut, press and hold SOFT for two

seconds and release. The following screen will open:

Flexi/Signcut

Software options Old COR Plug-in

Artcul

Signmaster/SCAL

BAUD setting based on
software selected

¢ To use a different software program to cut to the Skycut, press inside the appropriate circle. The Baud

Rate indicator will automatically change if needed.

1.15 Maintenance

Skycut machines do not require any kind of lubrication or routine checks. However, here are a few things to
keep in mind for successful operation of your cutter:

Keep the pinch wheels clean. Depending on the adhesive being used on the cutting mat, it's possible for the

pinch wheels to become sticky and pick up small pieces of cardstock or other material being cut. This can
lead, in some cases, to the mat skewing or ruining materials during subsequent cuts. To clean the pinch
wheels, use a lint-free cloth and an adhesive remover such as isopropyl alcohol or Un-Du to clean the pinch
wheels thoroughly.

Keep the grit shafts clean. Equally important as the pinch wheels, the grift shafts beneath the cutting mat
should also be free of adhesive and tiny bits of material. They can be cleaned the same way as the pinch
wheels. Note: Do not pour cleaner onto a grit shaft. Instead, dab some adhesive remover onto a lint-free
cloth and then use the damp cloth to clean the shafts. You can also use tweezers to remove any material or

adhesive that is stuck to a shaft.
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e Keep the cutting mat clean and sticky. As mentioned in the Section 1.08.2, the cutting mat can be washed
with soap and water to remove small invisible pieces of material which are reducing the tackiness of the
cutting mat. After drying, you can add more repositionable adhesive, if needed.

e Check your blade holder, as needed. If suddenly you cannot get a clean cut, check the blade holder for any
tiny slivers of material that may have been caught up by the blade and fed up inside the blade holder.

e |f you cut vinyl or other backed materials regularly, you may need to replace the cutting strip at some point.
You will be able to tell based on seeing deep cuts in the strip and an inconsistency in the cutting. Contact
your dealer for information on obtaining a replacement.

1.16 Other Useful Tools and Supplies

e The following list has items you may or may not need while enjoying your Skycut. These are suggestions
based on twelve years of collecting information from other cutter owners:

¢ Brayer or Rolling Pin: (1) to apply lint from a towel onto an overly sticky mat (2) to press materials
evenly onto a mat for cutting

¢ Post-It Notes: (1) for setting blade/tool tip height above a material (2) for draw and cut applications

¢ Old Fluffy Bath Towel: (1) to dry a washed mat (2) to apply an invisible layer of lint onto an overly-
sticky mat

¢ Dishwashing Soap: (1) to remove visible and invisible fibers from the mat, thus renewing the adhesive
(2) to clean the mat well before adding more adhesive

¢ Soft Brush: (1) to gently remove waste scraps during the washing of a mat. Refer to Section 1.08.2.

¢ Artist Palette Knife: (1) to gently remove cut shapes from a mat (2) to scrape off small waste pieces
from a mat

¢ Blue Painter’s Tape: (1) to tape around the edges of thicker materials that might slip during cutting

¢ Repositionable Adhesives: (1) to add more adhesive to a cutting mat (most any brand or type can be
used, provided it is repositionable). Refer to Section 1.08.2 for suggestions and instructions.

¢ Adhesive Removers: (1) to completely strip a cutting mat of adhesive (2) to disarm adhesive long
enough to remove large scraps of material that will not peel off

¢ Lint-free Cloth: (1) for dusting off your cutter and cleaning pinch wheels and grit shafts

¢ Awl or Paper Piercer (or other sharp pointed tool): (1) to pick or lift out a test cut to verify results

¢ Stabilizers: A stabilizer is an adhesive material that is applied to the bottom of the material you are
cutting so that cleaner cuts can be achieved. The stabilizer works in one or more of the following ways —
(1) provides firmer contact with the cutting mat (2) provides a final layer that does not need to be cut if
the stabilizer will be removed after cutting (3) prevent some slightly-elastic materials from being
stretched by the blade. Recommended stabilizers include freezer paper, Thermo-web Heat n’ Bond,
and Steam-a-Seam 2.

¢ Double-sided Tape: (1) For securing metal tags or charms to the cutting mat for engraving

¢ Non-slip Shelf Liner: (1) To place under cardstock and other material when embossing
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2. Cutting

2.00 Quick Reference for this Chapter

How to properly mount the blade holder: Section 2.01.3

How to control which shapes get cut: Section 2.02.1

How to control where shapes get cut: Section 2.02.2

Understanding Blade Offset and Overcut: Section 2.03.3 and Section 2.03.4
How to set a very precise origin: Section 2.05.1

How to add weeding lines to a cut: Section 2.06.3

Checklist before cutting: Section 2.07

How to get shapes to cut to precise dimensions: Section 2.08

How to know which settings to adjust to solve cutting issues: Section 2.09

The Most Common New Owner Mistakes:

2.01 What You Need to Understand About Cutting

Too much blade is exposed on the blade holder (material is lifting up and/or tearing) - refer back to Section
1.07.3

The blade holder or test pen haven’t been properly mounted - refer to Section 2.01.3

The pinch wheels are not properly positioned (material or mat is sliding around or bunching up during the
cut) — refer back to Section 1.09

Failing to do a test cut (recommended cut settings are not working) — refer to Section 2.01.5 and 2.09

Not practicing enough with the test pen and paper (shapes are not cutting in the correct locations) — refer to
Section 2.02.2

IMPORTANT: Please read all of 2.01!!!

2.01.1 You Have To Make Mistakes

To be a successful owner of a Skycut, you need to keep in mind a few factors:

¢ The key to becoming successful at cutting is to do a lot of it.

¢ You'’re going to make mistakes. This is normal and part of the process of mastering a cultter.
¢ Read all of Sections 2.01 and 2.02.
0

Perform test cuts before cutting large projects. It prevents wasted material and preserves your valuable
time.

2.01.2 Record Your Successes

As you have successful cuts, take note of the settings you just used, such as Force, Speed, blade type,
number of passes, brand of material, etc. There is a blank form in Section 2.10 that you can print and use to
record your results. There are also suggested settings for common materials at the end of this chapter. Use
these as starting guides but remember that your results may vary based on the many factors which can
affect cutting.
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2.01.3 Installing the Blade Holder, Test Pen, or Accessory Tools

e The gold blade holder has a rim around the outside that will, when cutting most materials, rest on the blade
holder seat. Thus, when inserting the blade holder, loosen the front screw until the blade holder can drop
down so that the rim is below the top part of the clamp:

Top and bottom

parts are the clamp Rim of blade holder is resting

on the blade holder seat

e The Blade Height is the distance from the tip of the blade to the top of the material you are about to cut.
Thus, in the photo above, you can see that there are several millimeters of Blade Height which is important
for two reasons:

0 You do not want the blade dragging across the material when the blade holder is moving from the origin
to the first shape to cut (or between shapes).

0 More force is applied when there is a drop distance for the blade holder to start cutting. This is also
referred to as “punch room” and provides more consistent cutting across the width of the machine.

e When cutting a very thick material, such as 2 mm craft foam, it is recommended that the blade holder be
pulled upwards before tightening the front screw so that the rim is touching the underneath of the clamp:

Rim of the blade holder is
touching the underside of the

IMPORTANT: Only install
clamp

this way when cutting very
thick materials!

e When using the test pen or an accessory tool without a rim, you’ll need to insert the tool using a spacer on
top of the material. A stack of 35 Post-It notes or 35 sheets of regular copy paper work well.

¢  The recommended method for loading the test pen or another accessory:

o Place the spacer on top of the material, with the material loaded into the Skycut.

o Loosen the screw on the blade holder seat and insert the tool so that the tip of the tool is touching
the top of the spacer:

Pen tip rests on
top of the spacer

Spacer is on top of material
which is on top of mat
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o Now tighten the front screw carefully making sure you are NOT pushing down on the blade holder
seat. Once tight, remove the spacer. You should feel the tool gently scratching the top of the
spacer.

o This distance will provide the tool some “punch room” to give extra force and more consistent
results.

2.01.4 Adjust the Speed, Force, and Number of Passes Based on the Material and Shapes

Using correct cut settings is equally important as the type of blade, blade length, and blade height. Refer to
Section 2.03 for details about each setting.

2.01.5 Perform Test Cuts!

You have two options:

(1) Perform the built-in test cut on the Skycut itself using the Test option on the Main Screen or from within
the Speed/Force Screen.

(2) Select any basic shape and size it to be around 0.3” — 0.5” (~ 8 mm — 13 mm):

o | personally like using a design with an internal shape, such as a ring. You can then easily see if the
blade is cutting into the mat (or into the backing sheet on rolled materials) when you lift out the cut
shape and observe where the internal shape cut. To locate a ring, click on the General Power

Shapes icon 4 on the left side Tool Panel and go to Basic Shapes>Basic.

o When cutting intricate shapes, use a small letter or a shape will lots of sharp turns for testing. For a
rhinestone project, use a small portion of your rhinestone pattern as a test.

There is a flow chart in Section 2.09 which will help you determine which settings to change when test
cutting a material.

2.01.6 Keep the Cutting Mat Clean and Sticky

Press your materials evenly to the mat. Consider using a brayer both before AND after cutting. Repressing
the material after cutting can greatly aid in weeding the cut shapes from the waste.

When necessary, tape thicker materials to the mat to keep them from slipping during the cut.

If you cut a range of materials, you might need more than one mat so that you can use stickier mats for
certain materials.

Refer back to Section 1.08 for information on cleaning the cutting mat and adding more adhesive.

2.01.7 Don’t Get Frustrated, Get Help!

Besides having your own Skycut dealer as your first line of contact, there are other resources where you
can ask questions and get answers. Utilize the resources listed in Section 1.01.

2.02 Choices Before Cutting

There are a number of factors under your control for cutting:

0 What shapes to send to the cutter: Section 2.02.1
0 Where the shapes will be cut from the material: Section 2.02.2
0 What tool(s) will be used for cutting (or drawing, scoring, engraving, etc.): Section 2.02.3
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0 What settings will be used: Section 2.02.4

2.02.1 Controlling Which Shapes Will Cut

e There are three ways to control whether a shape will be cut or ignored. In explaining these options, the
following shapes have been added to the Drawing Area. Note that this file (called Controlling What Cuts) is
shared in a zip file available here.

0 Option 1: If no shapes are pre-selected, then all shapes will be sent to cut. However, if you pre-select,
for example, only the “Skycut” and the arrow, then only those shapes will appear in the Send to be Cut
Preview:

4|

L 3

These two /'Skycut . =

shapes are

. . ) - o = Only those two

celected \ ‘ ORYCUT o T shapes appear in
| N & Preview

. . : L v

o A more common practice is to select all objects of one color and only have those shapes sent to cut.
To do this, go to Edit>Select by>Color (or use the shortcut key “S”) and the following window will
open where you can, for example, mark Red to be selected. Then the Preview will only have
“Skycut”, the red circle, and the red star present:

7.5121in
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https://drive.google.com/file/d/1cECETKrdKePCkAEXB46EYMF5xmuhiw1G/view

Select Objects hd

select by Color It's also noted here that
Select  Color Qty only red shapes are

| Il Black 1 selected
O Ml Bue 2
B Red 3

Mark the box
by Red

Click on OK Only the red

~<—— = shapes appear in
" Preview

6in

v

Select Al Invert Cancel

12.896 in

o Along the same lines, you can select all objects of type and only have those shapes sent to cut. To
do this, go to Edit>Select by>Object Type (or use the shortcut key “O”) and the following window

will open where you can, for example, mark Circle and Star. Then the Preview will only have
circles and the stars present:

Select Objects *

Select by Type Only the circles
Select  Color Qty ang stars appear
() Circle 2 in Preview

¢ Star 2

O Arrow 1

| A Text (Artistic) q

Mark boxes for
circles and stars

Click on OK -

11.776 in

Select All Invert Cancel

11.871 in

o Note that the icon at the top of the screen: will open a menu where you can then access the
same Select by Color or Select by Type options:

y ) g <4— Click on the Select by icon

-T> Select by Color...

_ W selectby Type

0 Option 2: Mark shapes not to be cut on the Objects tab of the Page Thumbnail Viewer:

o To access the Objects tab, click on the small icon to the left of the palette:
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Click this blue =77, me o ——————  (Click the Objects tab
arrow " - * K 5 m;’i . o

' o Armow (1)

Skycut

Ab Atistic Text (2)

v
4
&

ol @ ¢
e <

|
bl [ [

All of the shapes
appear in a list

Yo Star (3)

*

[ ]
v INN "EEEEE SEN EEE

v HEN EEEEE TEE e

»*

Yo Star (4]

Q Circle (5)

’
<
-
L]

o Select a shape, such as the arrow. On the Object tab, it can then be set not to cut:

Click this icon to Arrow will not cut
turn off cutting

o Dbjeiy . obje:/
N a —

" > ¥ | 9 [ioom %y [“]Zoom
Arrow is A o
selected -
o Arrow (1) Ly Arrow (1)

Arrow is no longer in Preview ——»

11.776 in

B

A—

3,456 In
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Option 3: Cutting can be controlled by color from within the Send to be Cut window. Click on the
Separate by Color option and a drop-down menu will appear:

Vinyl Cutter (Plotter)

Select Model

Media Width

Job Name

General Options

/

[sreuT: vas v| | properties
24,803 in =
Quantity

|Chapter 2 Example for Control Over Which II| 1 ﬂ
[ rotate [] Advance After Plot
[mirror [] Absolute (position)

Separate by Color
[ Registration Marks |- Black v-|_

Mark the
Separate by
Color option

Drop-down menu
of colors used in
the project

o Inthe Preview window, shapes with the current color from the menu appear. Also, the color is

selected at the top:

]
Quantity

r Which It| |1 3]

Black is selected =~ [JAsvanceafter piot

in the drop-down
menu

[[] Absolute (position)

Separate by Color

[CEa—

[] Auto Weed-Box

bl

Black is outlined here

SKYCUT: V24, 24803 in
Il Black Color (1/3

7.1472in

o Switching to blue changes the window accordingly:

_ ]

Properties

Quantity

| =
2r Which 1t| |1 :J

Blue is selected
in the drop-down
menu

[[] Advance After Plot
[[] Absolute (position)

\ [ separate by Color

[———p

[ Auto Weed-Box

[ ___EN

\

SKYCUT: V24, 24.803 in
I Blue Color (3/2)

11.871in

Blue is now outlined

=

©
s

The one black object is the
only shape shown in the
Preview

The two blue objects now
appear in the Preview

o Note that you can also change colors by clicking on those colored rectangles above the preview.
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2.02.2 Controlling Where Shapes Will Cut

e This was briefly covered in Section 1.13 where the Rotate and the Absolute (position) options were
introduced.
¢ Default: Moves the shapes to align with the origin you have set based on the blade tip.
¢ Absolute (position): Cuts the shapes where they are positioned on the Drawing Area.

¢ Print and Cut (aka Contour Cutting): Cuts the shapes relative to where registration marks are
scanned:

o This is the mode used when you want to print images on your printer and then have the Skycut cut
them out.

o Registration marks are printed, along with your images. The printout is placed into the Skycut and a
built-in camera automatically locates and aligns with each printed mark. The Skycut will then cut out
your shapes based on triangulation. This is far more precise than Absolute (position) because it
takes into account not only any misalignment of your printout in the cutter, but also any errors in the
printing. Most printers do not print images precisely in the location on the paper as they are located
on the screen.

o Note that raster images (.JPG, .BMP, .PNG etc.) will need to be traced first so that cut lines are
created. Section 3.04 will present an example.

o Refer to Chapter 3 for complete instructions on calibrating the camera and examples of PNC
applications.
e You can also rotate a design for cutting, relative to how it appears on the Drawing Area:

¢ To rotate the project, go to Send to be Cut and mark the Rotate option:

Send to be Cut
General Cutter Control Settings Tiling/Panels

Vinyl Cutter (Plotter)

Select Model ‘ SKYCUT: V24 £ | Properties
Media Width 24803 in =
Quantity
Job Name ‘Chapler 2 Example for Control Over Which II| 1 ﬂ
———p [ARotate [] Advance After Plot
[ mirror [] Absclute (position)

¢ For example, in a project with long text, it is more convenient to view and edit the text in a left-to-right
orientation:

Craft Show - Saturaay, October 27th - Ciglo Elementary School

¢ However, when you then send this project to the Preview window, you will observe that it is too wide to
cut from left to right on your Skycut:
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Project is too wide to | g

cut left-to-right
T - Ok -

emefay Scfog

The red lines and dimensions |
also indicate the project —>|
cannot be cut

&

55.432 in

¢ Marking the option for Rotate will then rotate the design and allow the project to cut:

]

WIS )

)

< R_otqted proj_ect will now fit _
within the width of the machine

[ i

A

S

g
by
B5. 432 in

R o) -

'
o

iy

I

The black lines and dimensions —_ >
indicate the project can now be cut

4.764 In

2.02.3 Selecting the Tool to be Used for Cutting

e To select the tool you'll be using, open the Send to be Cut window and click on the Open Blade Settings
Library icon:

Click on this icon
Send to be Cut

General Cutter Control Settings

Cutter Settings

[ Blade Offset 0.30 S ) Passes |1 ﬂ

[] Cut hales first Default

e The Blade Settings Library window will open. Click on the down arrow to the right of Description where
you can access a drop-down menu for the Blade Type:
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Click here

' Blade Settings Library Blade Settings Library

Select Blade Preset Select Blade Preset
Description - U Description o
! Blade Type v Blade Type v
Default
Drag Knife
Drag Knife (30deg)

Blade Offset 0.30 mm Update Blade Offset Drag Knife (45deg)
Over Cut 0.00 mm Over Cut Drag Knife (60deg) B TOOI menu
Pen Toaol

Score Tool
Fold/Crease Toal
Apry = Embass Tool o

e Selecting one of the options, such as 45 degree blade will display an image of the blade, the Blade Offset
and Overcut assigned as a Preset:

Blade Settings Library X

Select Blade Preset

e tion 45 degree blade vl + =
Color of cap on a T
Skycut 45° blade p Blade Type Drag Knife (45deg) v
Blade Offset 0.35 mm Update Presets for Blade Offset
Over Cut 1.00 mm and Overcut
Apply Cancel

e Sections 2.03.3 and 2.03.4 will explain Blade Offset and Overcut settings. Section 2.04 will explain how to
modify these settings, if needed and save as a Preset.

2.02.4 Determining the Cut Settings

e There are three locations in SignMaster where Cut Settings can be selected:
¢ Send to be Cut>Cutter Control tab (which was covered in Section 1.13)
¢ Send to be Cut>General tab
¢ Vinyl Spooler>Cut Options tab

e Send to be Cut>General

¢ Use this location when you need to assign different settings to different layers of your project. For
example, let’'s say you wanted to use the embossing tool to score lines in a popup card, followed by
cutting out the card itself. Or, another example would be using the test pen to draw a design and then
cutting a contour around it. Under General Options, Assign Tools by Color is marked and then, below
that in the Cutting Tool Presets section, individual colors can be highlighted and cut settings assigned
by selecting a Preset or by clicking on Edit:
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Mark Assign Tools by Color

General Options
\ [[]Separate by Calor

[ Registration Marks Assign Tools by Color
Cutting Tool Presets
Caolor Mame Cutting Preset Blade Type Blade Preset
A C0|0r is se|ected m
I Gue

A Preset is selected or settings

can be entered by clicking on Edit \»
w Edit 5 Reset Include Color

¢ More details for using this feature are covered in Sections 4.01.1 and 4.02.2.

Vinyl Spooler>Cut Options

¢ Use this option as an alternative to entering settings via the Cutter Control tab. It can be accessed from

the Properties button in the Send to be Cut window. You will also use it in print and cut (contour cut)

applications to check and adjust cut settings as well.
Send te be Cut
General Cutter Control Settings Tiling/Panels

Vinyl Cutter (Plotter)

Select Model | SKYCUT: W24 e | Properties

Media Width 24803 in =

-

Quantity

Job Name |Chapler 2 Example for Control Over Which II| 1 ﬂ

< C_Iick Properties_to open
Vinyl Spooler window

¢ Inthe Vinyl Spooler window, click on the Cut Options tab and the cut settings are located in the lower

section of that window:

Section 2.03.3 —» [ Blade Offset 0.35 R o Calibrate
Section 2.03.4 —» Overcut 1.00 =
Blade type Drag Knife (4bdeg) R

Additional Options

Tool Select Tool 0 | Priman
Section 2.03.1 — [A cutting Force 50 =15 g
. [ Cutting Speed (8 |400 S| emss
Section 2.03.2 =
[=] Travel Speed {109 | 500 =15 cm/s

These settings should be understood thoroughly, as you will be adjusting them often as you change

materials or as your blade dulls over time. Note the prior screenshot shows the section number to go to for

more information.
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2.03 Cut Settings

o Before presenting the various settings, note that the Force and Speed settings can be set on the control
panel itself. In order to cut from SignMaster and use the settings on the Skycut, uncheck these boxes in
either of the two places where the settings can be made:

0 Send to be Cut>Cutter Control window:

Force / Speed Options

Preset Condition ~ Reset
i [JForce =5
Uncheck these boxes if Speed and (oo n
. wi Speed =T
Force settings on Skycut are to be used - AT
[ Up Speed (5) |250 =15

¢ Vinyl Spooler>Cut Options window:

Additional Options

Tool Select Tool 0 w | Primar

==

=

Force settings on Skycut are to be used - [cutting Speed ) |200

Uncheck these boxes if Speed and [ Cutting Force
[ ravel Speed (5) |Z50

Ak 4][w] 4]

2.03.1 Force

e Force (also called Pressure) ranges from 1 to 160 where the maximum of 160 represents ~2000g of cutting
force. If it is set too low, the material cannot be cut. In fact, it is recommended that the minimum setting is
always ~20 or higher. However, if it is set too high, you will get bad cutting (even incomplete cutting at
times) and tearing of the material. Always perform small test cuts before cutting your actual project and
make adjustments in order to get a clean test cut before proceeding with your larger cut.

e Dull blades will need more force than new blades, thus anticipate increasing the force over the life of the
blade.

e When cutting materials that can use either blade, the 45° blade (red cap) will need a little more force than
the 60" blade (blue cap), because of the extra contact with the material being cut and because the 60° blade
is cut much thinner, making it a “sliver blade.”

e As noted earlier, this setting can be made on the Skycut control panel instead. Press the Force/Speed icon

, and then set the FORCE to the desired level.

2.03.2 Cut Speed and Up Speed

e Cut Speed (also called Down Speed) is how fast the blade travels while it is in the “down” or cutting
position. Up Speed (also called Travel Speed) is how fast the blade travels while in the “up” position, such
as when it is moving from the origin to the location of the first shape to cut or when moving from one cut
shape to begin cutting another.

e The Skycut has 13 speed settings ranging from “snail’s pace slow” to “insanely fast.”

¢ The settings from 1 through 4 are the slow speeds and should be used when cutting dense difficult
materials, such as chipboard, craft plastic, styrene, and balsa.

¢ The settings from 5 through 8 are medium speeds and should be used for easy-to-cut materials, such
as cardstock, vinyl, iron-on transfer, and rhinestone template material.
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¢ The settings from 9 through 12 are the fast speeds and are useful for engraving, embossing, and
drawing. You may, however, find that some materials will cut well at the faster speeds.

e Cut Speed is usually more important to control since the blade may need more contact time with a
particular material. Up Speed can usually be left quite high although, for print and cut accuracy, it may need
to be lowered if there are many shapes to be cut from a printout.

e On the Skycut control panel, the default setting is to have the Up Speed and Cut Si eed the same and

referred to as SPEED. This can be adjusted by pressing the Force/Speed icon and then setting the
SPEED to the desired level. In order to enter a separate Up Speed on the control panel, refer to Section
1.14.1.

2.03.3 Blade Offset

e Blade Offset is the horizontal distance from the center of the blade shaft to the tip of the blade. A pen or
engraving tool has an offset of 0 because the tip is centered with the center of the pen/engraving tool shaft.
But a blade is different:

Imagine a line
passing through
' the center of the

test pen or
blade

The Offset is the distance
between the center of the
blade holder and the tip of the
blade.

There is no
Offset on a
pen.

o |f you set the Blade Offset to 0 when cutting with a blade, corners will be rounded. On the other hand, if it is
set too high, bubbles will be cut on sharp corners:

Offset is too low: Offset is too high: bubbles
corners are rounded appear at the corners

e Currently it is recommended that a Blade Offset of between 0.25 — 0.35 be used for each of the three types
of Skycut blades. Any time you order new blades, check for the recommended Blade Offset on the
packaging. However, it's not unusual for blades to be slightly off-spec. Based on cutting a rectangle or
square, increase or decrease the Blade Offset in increments of 0.1 or smaller until the shape has perfectly
square corners.

e Alternatively, SignMaster has two built-in Blade Offset calibration routines which can be used to determine
the best Blade Offset setting for the current blade in use. Here are the steps to access either one:

¢ Select the material you want to use for testing, such as vinyl, paper, or cardstock. Note how much
material will be needed for the test you select and add a few inches to these dimensions:

o Normal Test: Width: ~9” (354 mm) Height: ~3.5” (89 mm)
o Quick Test: Width: ~4.5” (114 mm) Height: ~1” (25 mm)
¢ Install the blade you wish to calibrate into the blade holder and mount the blade holder in the Skycut.

Enter appropriate settings in SignMaster or on the Skycut control panel. Test cut a small shape to make
sure the settings are correct.

¢ Go to the Vinyl Spooler window and select the Calibrations tab.
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¢ Click on the Blade Offset icon and a new window opens:

1. Select
Calibration tab

Instructions

To perform this calibration, you will need to load a
small piece of vinyl into the cutter.

4. After loading material and
verifying cut settings on the
Skycut, click here.

F Preview ‘»- Cut Optiens .5 Connection [ calibration
Using the blade that you wish to calibrate, click
on "Perform Calibration” to cut the calibration
test.

—Ll— . k
) \/ *i+ # | Perform Calibration
. - .
s b4 G !

Cutter Scal .
Blade Offset usker seae Laser Offset (Quick) Normal Test -

2. Click on Blade
Offset icon

Calibrate your Device

3. Select either Normal Test
or Quick Test (note material
requirements below)

¢ In both tests, the instructions on the screen will guide you on how to enter the best result and then will
display the recommended Blade Offset to use. This new Blade Offset value will then be updated in the
cut settings. Instructions on how to add this setting as a Preset are covered in Section 2.04.

2.03.4 Overcut

e Overcut is related to Blade Offset in that it isn’t needed when using a pen, embosser, engraver, and so
forth, because the tips of those tools are aligned with the center of the tools themselves. However, leaving
Overcut at 0 when using the blade holder will result in large shapes not quite closing:

Overcut is too low:

D paths do not close

e |n some cutting programs, Overcut is not a separate setting but rather automatically calculated and applied
based on the Blade Offset entered. However, in SignMaster, you can enter an actual Overcut setting and
should do so any time a blade is used.

e In general, the blade type doesn’t greatly affect the Overcut required. Try using 1.00 mm. In the event you
cut a large closed shape, like an 8” circle, you may find that you'll need to increase Overcut to 2.00 mm.

2.03.5 Passes

e The Passes setting causes each individual path to be cut the set number of passes before the blade moves
to the next path to cut. This is better than just repeating the entire cut as each repeated pass is cut with the
blade held down throughout the repeated passes, resulting in cleaner cutting.

¢ In general, when increasing Passes, the Force setting can be decreased. For example, you may find a
cardstock that requires a Force of 55 to cut in a single pass will only need a Force of 45 if cutting in two
passes.

o Passes is recommended in the following situations:

¢ Cutting thicker denser materials, such as chipboard, where multiple passes allow the blade to
progressively “carve” through the material

¢ Cutting certain fibrous materials, such as fabric, where a second pass will ensure that all of the fibers
have been cleanly cut

¢ Cutting intricate or detailed shapes (such as script titles) from certain materials, such as heavy or
textured cardstock, where a single pass may leave certain spots not cleanly cut
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¢ Cutting rhinestone template material where a second pass results in much cleaner weeding of the cut
circles

You will find a Passes setting in the Send to be Cut>Cutter Control window, under the Cutter Control
tab:

Send to be Cut

General Cutter Contral | Settings Change Passes here
Cutter Settings /
EI -
[ Blade Offset 0.35 D F pese 2 12
[Jcut holes first Drag Knife (45deg) - 45 degree blade

Alternatively, you can activate Passes on the control panel. Press the USB button on the Main Screen and
you will see a Passes Set button in the window which opens: Press it to open the Passes screen:

NOTE: If your screen does not
have Passes Set displayed,
please go to Appendix B for

activation instructions.

Press the Passes Set button to open the following screen:

Openrecut Mark this option to activate Passes

Recut im Use + and — buttons to enter
CCLEHIHES: number of Passes

IMPORTANT: The Open recut option will default to off whenever the Skycut is first powered on. Thus,
make a mental note (or, even better, put a Post-It note on your cutter) to turn this option on when using
multiple passes.

Note: You can also turn activate passes by color of the shape. Refer to Section 2.06.5.
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2.04 Presets

Presets allow you to save your settings for a particular blade type or material.

2.04.1 Saving a Preset for a Blade Type

Let’s say you conducted the calibration for Blade Offset in Section 2.03.3 and determined it to be 0.35 for
your red capped blade. To save this setting as a preset, use the following steps:
o

Go to the Send to be Cut>Cutter Control window and click on the icon to the right of Blade Offset to
open the Blade Settings Library:

Click on the Cutter Control tab

Open Blade Settings Library
Send to be Cut /

General Cutter Control  Settings
Cutter Settings

[ Blade Dffset

U.a =
]
[] Cut hales first Drag Knife
0

Fasses

I
tn
C

Blade Settings Library

In the Blade Settings Library, click on the + icon to the right of Description and a window will open
where you can enter the name for your new preset:

Click on +

Enter a new name
\ ) |
Description

| Select Blade Preset

Select Blade Preset

Blade Type Drag Knife (45deg)

Description v
n Add Blade Preset |
v ‘
Blade Offset

+ -_—
x
Please enter a name for tijis Blade
Skycut 45 Degree Red Blade|
0.35 mm E
Over Cut 0.00 mm
Appiy Cancel

Appt: Cancel

Click on OK and then select which blade type you are using for this new preset Enter the new Blade
Offset and Overcut values. Then click Update:
Blade Settings Library

Select Blade Preset

x
Description Skycut Red Capped Blade v | -+ —
HBiade Type v 4— 1. Select type of blade
J Hade Offset 0.35mm upsaste ¢——— 3. Click on Update
2. Enter the Blade Offset SV' Over Cut 1.00mm
Overcut values, as neede

¢

Apply

&——€r=—""— 4 Click on Apply
Click on Apply to close the Blade Settings Library. The new preset will now be available for selection
in the Description menu.

If you need to delete a preset, select it from the Description menu and click on the

icon to the right.
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2.04.2 Saving a Preset for a Material

o IMPORTANT: As was noted in Section 2.02.4, Up Speed (aka Travel Speed) is not functional in
SignMaster. Thus, if you need a separate Cut Speed and Up Speed for a particular material’s preset, it is
recommended that the preset be made on the control panel.

e Similar to the blade holder preset, you can enter settings for a particular material. For example, let’s say you
cut Georgia Pacific 110 Ib cardstock at a Force of 55 and a Speed of 8. Use the following steps to create a
new preset in SignMaster:

e Go tothe Vinyl Spooler>Cut Options window and click on Edit Presets:

F Preview r Cut Optiens 5" Connection T& Calibration

T SKYCUT: V24

Media Size
Media Width 24,803 in = edia
Media Length 0.000 in =

Click on Edit Presets
[ Cut in Strips

Cutting Options

Preset Mode: ~ Edit Presets

e The SKYCUT V24 window opens. Click on the + icon to the right of the current Preset Mode name and a
window will open where you can enter the name for your new preset:

Click on +
Enter a new name
Preset Cutting Modes . '
Preset Cutting Modes |
Preset Mode: < Current Settings »
== N e d Preset Mode: < Current Setffings > ~ 4+
Cutting Opti
[ETE NELTS Cutting Options
Bache - Blade Preset ~
Blade type Drag Knife (30deg) w Blade type Drag Knife [30deg) 5 I
B Blade Offset 0.35 = B Blade Offset 0.35 - \ \
- |
Overcut 1.00 = ]
hd Overcut | add Preset Conditic X
Additional Options Additional Optior Please enter an for this Preset
Tool Select Default ~ Tool Select Georgia Pacific 110l CDVerl
[ Cutting Force 50 = e (] cutting For¢ Cancel
[[] Cutting Speed {5) |[250 =3 mm/'s ["] Cutting Spet m/s |
() Travel Speed (5) |[250 =1 mm/s [ Travel Speed (5 |250 =18 mm/s
Cutting Options (selected contours) Infa Cutting Options (selected contours) Info
© Hene - Default © Hone - Default
(O Muiti-cut (thick media) () Mutti-cut (thick media)
(C) Dash cut () Dash cut
() Multi Fold/Crease Lines () Multi Fold/Crease Lines
(:] Thick Sheet (lift blade at corners) [:1 Thick Sheet (lift blade at corners)
Apply Cancel Apply Cancel

e Click on OK and then complete the rest of the window with the settings for that material:
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Preset Cutting Modes

Preset Mode:

Cutting Options

Georgia Pacific 110k Cover

New Preset name

Blade Preset Select Blade Preset
Blade type Drag Knife (45deg)

- ’ Blade Offset 0.35
Overcut 1.00

Additional Options
Make all necessary

. Tool Select Default ~
changes to settings -
B cutting Force 55 =18 4
@) Cutting Speed  (8) | 400 =1 mm/s
[T Travel Speed (s} |250 =i mm/s
— Cutting Options (selected contours) Info
. Q) None - Default 2 5 can be applied to
SeleCt’ if ne_eded’ fr(_)m () Muiti-cut (thick media) \l)
these additional options— ) pashcut

(refer to Section 2.06.5) (O Mt Fold/ Crease Lines

(_) Thick Sheet (lift blade at corners)

L Click on Apply
sppty %

Click on Apply to update the Preset Mode menu with this new listing. Click on Done to close the Vinyl
Spooler window. The new preset will also how be available in the Send to be Cut>Cutter Control window,
in the Preset Condition menu:

Send to be Cut
General Cutter Control  settings Tiling/Panels

Cutter Settings

[[] Blade Offset 0.35 o Passes |1 ﬂ
[ Cut hates first Drag Knife (45deg) - Skycut Red Capped Blade

Force / Speed Options SeIeCt new preset here

‘Georgia Pacific 110 b cover ~ Reset

Preset Condition

Georgia Pacific 110 b cover -
. EAIF 55 =k E
Settings are Eefrorce ol
[] speed (8 |00 Sk
updated based on - -
[ up speed (5) 250 = (4

Preset selected

If you need to delete a preset, return to Vinyl Spooler>Cut Options>Edit Presets window, select the
preset from the Preset Mode window click on the “-* icon to the right:

SKYCUT: V24 s

Georgia Pacific 110lb cover ~ ~| =+ /

Click on “-“icon to
delete preset

Preset Cutting Modes

Preset Mode:

Presets for Force and Speed only can also be saved on the Skycut control panel. To create a preset:

¢ Press the Force/Speed icon to open the Force/Speed screen:
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Adjust settings by sliding bar

or using + and - buttons

Click on Save

SPEED:

7(13.6in/s)

¢ Make the necessary changes to the SPEED and FORCE settings. Select Save and the following screen

opens:

Select an

unused box ™~

Cardstock - 65# name?
18
Wall Vinyl name8 ‘
£} K2
Cardstock-110#GP name9
|5 4] Sel
elect
name 5 namel10 Rename
Rename Save &L

[ —————

Pen nameb

V] |14
Cardstock - 65# name?

I3 £:3
Wall Vinyl name8

E] 1K)
Cardstock-110#GP name9

namel0

Rename

¢ Press one of the unused preset boxes, e.g. name5, and it will turn blue indicating it is highlighted. Select

Rename.

¢ A window opens where you can enter the name for the new Preset. The characters are entered in the
same manner as the Password entry window in Section 1.12.2. Note that there is a 15-character limit.
Click on OK when done.

New preset name /

will display here

Switch to punctuation

Toggle to switch between
uppercase and
lowercase letters

Pistenbure

Click OK when done

Switch to
numbers

Delete last
character
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¢ You will now see the name of your new preset and you can press Save to add it to the saved presets
with the FORCE and SPEED you set. You will be returned to the Force/Speed screen.

—_—

SPEED: 7(13.6in/s
Pen nameb SPEED: (13.6in/s)
" E e
Cardstock - 65# name?
FORCE:
& 18
Wall Vinyl name8
[ )
New Preset Cardstock-110#GP name9
name
namel0

Press Save

¢ To verify the preset or to select a different preset, press Preset. The Preset window opens where you
can see all of the Presets, along with the settings for those presets. In that window you can also select
a different preset. Then you can select Rename to edit its name or select Load to select that preset’s

Force and Speed into the Force/Speed screen.
E Pen l nameb

SPEED: 7(13.6in/s) SPEED=9(176infs)  |SPEED=12(23.6in/s)

. - . Siaiis b
[Z Gardstock-65# | name?

SPEED=10(19.6in/s) [SPEED=12(23,6in/s)
FORCE=70 FORCE=5

B WallViyl |8 name8
SPEED=10(19.6infs) [SPEED=12(236in’s)
FORCE=20 FORCE=5

& Cardstock-110#GP |2 name9

SPEED=8(15.6in/s)  [SPEED=12(23.6in/s)
FORCE=55 FORCE=5

Select
Preset

name10
SPEED=12(23.6in/s)
FORCE=5

Select Rename to Select Load to change
edit the name Speed and Force to
these settings

2.05 Setting the Origin before Cutting

e Before you cut, you should check to see where the blade tip is located in relation to the material so that the
shapes will cut in the appropriate location.

o IMPORTANT! The Skycut V24 has a maximum cutting width of 24 inches. If you move the head too far to
the left to begin the cut and your project is wide, you may exceed the left side limit and cutting will stop at
that point with no option but to abort.
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e To set the origin, press the arrow buttons on the main screen of the control panel. Remember that the
middle button can be toggled between regular speed and a slow speed for more control:

s @ B

ReCul USB

s @ B

ReCul USB

TSN =—)

Stop Speed/Force Test

© @& f

Stop Speed/Force Test

Press here to
toggle origin
setting speed

e |n general, you set the origin near the lower right corner of the material, as you did during your initial test
drawing in Section 1.13.

e |f you want to set a “return-to” origin in order to move the material or mat to check the cut before removing
from the Skycut, refer to the instructions in Section 1.14.1 (Show Point).

2.05.1 Setting an Origin Using the Camera

¢ In the event you need to set an extremely precise origin, the Skycut’s built-in camera can be used:
(1) Go to Section 3.03 and perform the camera calibration.

(2) Choose where you want the origin to be set. You'll need an “origin target” to use when the camera takes
a photo. It can be a dot on your material, the corner of your material, the intersection of grid lines on the
mat, etc. If you do choose the latter, make sure there’s a way to clearly distinguish which intersection
you want to use.

(3) On the Skycut’'s Main Screen, use the arrows to move the center of the blade holder roughly over the
origin target. In this example, a dot will be used.

(4) Select Set and Camera. In the Camera Screen, press OK. A photo will be taken and displayed. If
needed, press X3 so that you are zoomed out and able to see the origin target (dot) in the photo:

Origin Target (dot) Blue dashed +

Red +

(5) Press the center of the origin target in the photo so that the red + will be moved approximately over it:

65



(6) Press OK. In the new photo, the blue dashed + should be close to the origin target. Press X3 to zoom
in:
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(9) Press the Home icon to return to the Main Screen. The head should move so that the blade holder is
now located over the origin target and you can proceed with the cutting process.

2.06 Other Cut Setting Functions

e There are other functions and features available in the Send to be Cut window that may be useful
depending on your application. Some have already been covered. Some will be covered in this section.
Others will be covered in later parts of this manual. Note the section numbers for reference:

Section 2.02.2 » [ Rotate [ Advance After Flot €——  Section 2.06.1
Section 2.06.2 » []wirror [J#psoute (position) 4——  Section 2.02.2

General Options

[]separate by Caor 4——  Section 2.02.1 Option 3

Section 3.03 » [ Registration Marks [ Assign Tools by Color «——  Section 4.01.1
Section 2.06.3 P[] Auto Speed-Weed [] Auto Weed-Box «——— Section 2.06.3
Text Options
Section 2.06.3 p [ ] Easy-Lift Weed Marks
Section 2.06.4 p [ weld Text
Section 2.06.3 P [ | Speed-Weed Text Only HE=EE

2.06.1 Advance Mode

e The Advance After Plot option in SignMaster Pro is actually controlled on the Skycut itself. The function
can be opened by going to Set>Advance Mode on the control panel.

advance mode
lo start

Select from these

to end v _ three options

lo left

Length of feeding material: in

Use “-“ and “+” buttons to
set an advance amount

¢ to start will cause the blade holder to return to the origin after cutting.

¢ to end will cause the blade holder to advance forward to the end of the cut project.
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¢ to left will cause the blade holder to move to the left of the cut project.

¢ The settings below the option are activated when choosing either to end or to left. You can enter a
specific distance for the blade holder to advance. This is useful when cutting repeats of the same
project because it allows for the origin to be set automatically for the next repeated cut.

2.06.2 Mirror

Checking the Mirror option will apply a horizontal mirror to the shape (s) before cutting. This is useful in
applications such as:

¢ Cutting HTV in which the material is placed faced down so that the heat protection layer is not
penetrated by the blade

¢ Cutting vinyl to be applied to the inside of a car or home window but primarily viewed from outside of the
window

¢ When cutting certain non-homogenous paper materials in which cutting upside down yields cleaner
results

VTH omili —o2

(=]

6.554 in 6.554 in

Before applying Mirror After applying Mirror

2.06.3 Weeding Options

For those cutting vinyl and HTV, the weeding options in SignMaster are worth noting.

¢ Auto Weed-Box: Marking this option places a single weed box around the entire project:

4144 in

12.503 in 12.896 in

Before applying Auto Weed-Box After applying Auto Weed-Box — blue
border around design indicates weed cut

o Note: to change the size/offset of the weed box around the design, click on the Settings tab and
adjust, as desired:
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Click Settings tab

Send to be Cut

General Cutter Control Settings

Position
Position x Reset
Position y
Options
Weed Box Offset 0,187 in = Reset

/

Change offset here

¢ Auto Speed-Weed: Marking this option places a single weed box around the entire project with an
additional horizontal weed line through the middle:

3.489 rl

: 13.374 in
Before applying Auto Speed-Weed After applying Auto Speed-Weed — blue weed
box plus horizonal weed cut in the middle

Easy-Lift Weed Marks: Marking this option adds hooked lines to shapes with internal paths to make it

¢
easier to lift with a weeding tool:

14.341 in

Before applying Easy-Lift Weed Marks After applying Easy-Lift Weed Marks —
hooked cuts are added to internal shapes for
easy lifting during the weeding process

¢ Speed-Weed Text Only: Mark this option when your design has a combination of both text and other
shapes so that only the text will have Speed Weed applied:
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9.082 in

14.506 in 1

14 QllLi in

Before applying Speed-Weed Text Only After applying Speed-Weed Text Only —
text object has additional weed box plus

horizontal cut through the middle

2.06.4 Weld Text

e For script fonts, the Weld Text option will remove overlap between letters so that a word will cut as one
object. For example, if you go to View>Wireframe, you can see the overlap that will be cut when a script
font is used:

e You have the option to select the letters and apply the Weld function under the Shaping and Welding

Tools “|, thus removing overlap between letters:

e This, however, means you cannot change the font used or alter the spacing of the letters, etc., without
applying Undo. Therefore, the Weld Text option allows you to cut the text as if the Weld function has been
applied:

5.113in

! 13.6401in U ! ,3 640 in

Before applying Weld Text After applying Weld Text — overlap
between letters is removed

2.06.5 Additional Cut/Score Options

e There are 5 other options which can be applied when cutting or scoring. You can access these when setting
up a Preset (refer to Section 2.04.2) or after you select Assign Tools by Color (select a color in your
project and click on Edit):
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General Cutter Control Settings Tiling/Pal

Vinyl Cutter (Plotter)

Select Model SKYCUT V24
Media Width 24,803 in
Job Mame Draw and Cut
[ Rotate
[ mirror

General Options

] Registration

Cutting Tool Presets

Color Name Cutting Preset
Il Biack Pen Mode (Tool 0

/ Il (Contour Cut Cal...

1. Select a
layer
2. Click on > Edit
Edit

None-Default will always be initially selected. The other options, however, can be chosen based on

3. Addit
(covel

Preset Cutting Modes

Preset Mode:

Cutting Options
Blade Preset
Blade type

B Blade Offset
Overcut

Additional Options
Tool Select
8 Cutting Force

@ Cutting Speed  (7)
B Travel Speed 7

Cutting Options (selected contours)

O Hone - Default

(O Multi-cut (thick media)

(_) Dash cut

() Multi Fold/Crease Lines

Drag Knife (45deg)

0.35
1.00

Default

45
350
350

(_) Thick Sheet (lift blade at corners)

ional options
red below)

Apply

RMDIENIEID

ol || o ||

mm/s

mm/s

These options can be applied to

d contour colors (in main

gn program). You can also
ve them as a preset.

Cancel

situations such as needing more than one pass, perforated cutting, or even changing how the blade handles
sharps corners:

0

0

Multi-cut (thick media) — select this option and increase Quantity to control the number of passes

applied. This is the same as using the Passes option covered in Section 2.03.5 however in some cases
you might want only a single pass applied to part of your material and then more than one pass applied
to another part. One example is the cutting of laminated sticker sheets in which an inner contour cut is

only kiss cut through the top layer but a full cut is needed for the outside cut.

Cutting Options (selected ¢
() None - Default
© Muiti-cut (thick media)
(") Dash cut
(

) Multi Fold/Crease Lines
(_) Thick Sheet (lift blade at corners)

ontours) Mutti-Cut Options

Quantity

Dash Cut — select this option to apply a perforated cut to part of your material. This is useful for boxes,

pop-up cards, gift bags, etc. when the score lines can be dashed cut instead of creased:
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Cutting Options (selected contours) Dash (perforation) Options
() Mone - Default
() Multi-cut (thick media) SR 10.0 mm
9 Dash cut Gap length 2.0 mm
() Multi Fold/Crease Lines

() Thick Sheet (lift blade at corners)

¢ Multi Fold / Crease Lines — This option allows you to not only set multiple passes when using a
creasing tool but to further space those repeats when cutting thicker materials that will fold more easily
when the score lines have a slight gap between them:

Cutting Options (selected contours) Fold/Crease Options
() None - Default
= Line Qty 2 |Z| ||_
(_) Muiti-cut (thick media)

(O Dash cut spacing 0100 |  (mm)
© Muiti Fold/Crease Lines

(") Thick Sheet {lift blade at corners)

¢ Thick Sheet (lift blade at corners)— Some thicker materials, such as chipboard, do not cut cleanly
when the blade attempts to make a sharp turn at a corner. Crumpling at the corner can result. However,
if the blade overshoots the corner slightly before changing directions the corner will be much cleaner.
Note that Two Passes can also be enabled for those more difficult materials:

Cutting Options (selected contours) Thick Sheet Mode
() Mone - Default Cnr Owvershoot 0.200 Izl

() Multi-cut (thick media) I_I

) Dash cut
() Muiti Fald/Crease Lines
OThick Sheet (lift blade at corners)

2.07 Important Checklist Before You Cut!

Do you have your material on the mat and the mat inserted into the Skycut? (Note: materials with a backing
sheet, such as vinyl and iron-on transfer do not require a mat for cutting)

Have you selected pinch wheels positions that are roughly the same distance from the outside edges of the
cutting mat (or material, if not using the mat)?

Are the pinch wheels in use centered over grit shafts (located below the white rectangle labels)?
Do you have the pinch wheel lever raised (so that the pinch wheels are down)?
Have you set the blade length/exposure based on the thickness of the material you are cutting?

Do you have the blade holder firmly mounted in the blade holder seat and the blade tip at the correct height
above the material?

Have you set the Origin (location of the blade tip) at the bottom right corner of your material (or wherever
you need the origin to be)?

Have you set the Force? And the Speed? Do you need to do a test cut?
Do you need to turn on Passes for this material?

Have you selected the correct Blade Offset for the blade you are using?
Do you see the correct shapes in the preview window?

Do you need to select Rotate, Mirror or Absolute (Position) options? Do you know, with confidence, where
your shapes are going to cut?

Do you need to apply any weeding options?
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2.08 Scale Calibration

e If you were to cut out any particular shape, for example, a 10” x 10” square, you might find that it actually
measures 9-15/16” x 10-1/32”. It will be very close to 10” x 10” but perhaps just slightly smaller or larger in
either or both dimensions. Now this might be perfectly acceptable for the type of cutting you do. Therefore,
may not even be necessary to do this particular calibration. However, if you do want to make sure your
shapes are cut precisely to scale, the following procedure will allow you to calibrate your Skycut.

it

e The calibration process can be conducted in inches, cm, or mm. Both mm and inches will be presented
here. In general, it is recommended that mm be used, however, if you do not have a metric ruler, then you
can use inches instead.

e Before beginning this calibration, make sure the Scale setting on the Skycut itself is still set to 1.0 and 1.0.
On your Skycut control panel, go to Set>Advanced Settings> Scale. The following window opens where
you can check the current X Scale and Y Scale values:

X Scale:

1.0000
Verify X Scale and Y Scale . _ .

are both set to 1.0000

Use the + and - buttons to adjust Y Scale:

1.0000

@ B

e Return to the main screen. Then pick one of the two following sections and follow the instructions.

2.08.1 Scale Calibration Using Millimeters for Measurement

e SignMaster has a built-in resolution routine which can be used to easily perform this calibration:
¢ Goto the Vinyl Spooler window and select the Calibration tab.
¢ Click on the Cutter Scale icon:

| 1. Select the
& Preview v Cut Options 15_ Connection ﬂ Calibration < Calibration tab

Calibrate your Device

—L)=>
P T y
1 ¢ \ ++
L, AN 4 | —
L I %+
Cutter Scal
Blade Offset utter scale Laser Offset (Quick)

2. Click on the Cutter Scale icon

¢ A new window opens where you can enter the dimensions of a square or rectangle to draw with the test
pen. It is highly recommended that the dimensions be at least 200 mm. Note that in the current version
of SignMaster, the display in this window is always in inches. However, you can enter values in mm by
typing in “mm” after the number as shown:
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Adjust Cutter Scale

Calibrate Cutter Scale

This calibration will cut out a test box to help calibrate the
cutter's scale values.

Please load the cutter with enough material for the size you
select.

Click "Cut Test" to cut out the test.

Size of Test Box ‘Current Scale

Type in 200 mm
exactly as shown

Width 200 mnf
Length 9.843 in
Reset Scale Use previous calibration

Length

AN

Width

Cut Test Cancel

Press the tab key and the 200 mm will be automatically converted into inches. Repeat with Length:

Adjust Cutter Scale

Calibrate Cutter 5cale

This calibration wil cut cut a test box to help calibrate the
cutter’s scale values.

Please load the cutter with enough material for the size you
select.

Click "Cut Test" to cut out the test.

Width has been Size of Test Box Current Scale

converted to in
Width 7.8741in 100.00 %

Length ZOOmrd 100.00 %

Reset Scale Use previous calibration

Type in 200 mm
exactly as shown

*

Length

AN

Width

Cut Test Cancel

Click here to start
the drawing

On the Skycut, load a sheet of paper and insert the test pen. Move the test pen to the lower right corner
of the paper. Make sure you have proper settings for drawing and click on Cut Test to have the shape

drawn.

Using a mm ruler, carefully measure the Width (left-to-right) and the Length (top-to-bottom) that drew:

Feed the mat this direction ! SESESEEEEEsEEm

into the Skycut i NN NN
HHN— /\
| Y i
Width, X

—~

Length, Y
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¢ Write these measurements onto your sheet:

199.5 mm

201.5 mm

¢ These values can now be entered into the same Width and Length fields, again adding “mm” after
each number as shown:

Calibrate Cutter Scale Calibrate Cutter Scale
After cutting the test box, you will need to accurately measure After cutting the test box, you wil need to accurately measure
the Width and Length and enter these values in the area below. the Width and Length and enter these values in the area betow.
Once you have entered the measured values, click "Update” to Once you have entered the measured values, click "Update” to
apply the scale calibration. apply the scale calibration.
Size of Test Box Enter measured values here... Size of Test Box Enter measured values here...
Width 199.5 mni 100.25 % Width 7.854 in 100.25 &
Length 7.8741n 100.00 % Length 201.5 mn| 100.00 %
Enter actual Width and Enter actual Length
add “mm” and add “mm

¢ After entering each number, the scaling percentage is automatically calculated:

Calculated Scale values

Size of Test Box Enter measured values here... I \ / || l

Width 7.854 in .
Width
Length 7.933in
Reset Scale Cancel

Click on Update

¢ Click on Update and a prompt window will ask if you want to Apply Scale Adjustment. Click on Yes
and you'll be back in the Vinyl Spooler window. To verify the scaling, again click on Cutter Scale and
repeat the same steps. Make sure you leave your new scale factors in place by having the following
option marked:
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Size of Test Box Current Scale

Width 7.8741n Leave this checked for

each repeated test

Length 9.8431in

Reset Scale Use previous calibration

¢ Once your test rectangle is drawing at the correct size, the calibration process is complete.

2.08.2 Scale Calibration Using Inches for Measurement

e SignMaster has a built-in resolution routine which can be used to easily perform this calibration:

¢ Go to the Vinyl Spooler window and select the Calibration tab. Click on the Cutter Scale icon:

& preview v Cut Optiens .5 Connection & calibration 4+— 1. Select the
Calibration tab

Calibrate your Device

-0 . |

I —e

L ] - 3 +*
Cutter Scal
Blade Offset uster=e e‘\l_aser Offset (Quick)

2. Click on the Cutter Scale icon

¢ A new window opens where you can enter the dimensions of a square or rectangle to draw with the test
pen. It is highly recommended that the dimensions be at least 8 inches:

Adjust Cutter 5cale s
Calibrate Cutter Scale

This calibration will cut out a test box to help calibrate the Length
cutter's scale values.

Please load the cutter with enough material for the size you
select.

Click "Cut Test" to cut out the test.

Enter Width and

|
Size of Test Box Current Scale \ /

Length to use for test \
shape Width 8.000in 00.00 %
\Lengm\; 8.000 in

Reset Scale Use previous calibration Cut Test Cancel

:

Click here to start the drawing

Width

¢ Load a sheet of paper and insert the test pen. Move the test pen to the lower right corner of the paper.
Make sure you have proper settings for drawing and click on Cut Test to have the shape drawn.

¢ Using a ruler, carefully measure the Width (left-to-right) and the Height (top-to-bottom) that drew:
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Feed the mat this direction RS EaNEEaNssEEsssEsaE
into the Skycut 3::::::‘:‘::1 :::|:;:::§;
HN— Y
: YT I
Width, X
' > Height Y
=] 15 5 T O 0 v ) '7'7}':
¢ Write these measurements onto your sheet:
7 15/16inches 7
o
| 0 4 N T 1 T T 1 ) 0

¢ Convert the measurements to decimals and enter these values into the same Width and Length fields.
After entering each number, the scaling percentage is automatically calculated:

Calibrate Cutter Scale

After cutting the test box, you wil need to accurately measure Lengm
the Width and Length and enter these values in the area below.

Once you have entered the measured values, click “Update” to
apply the scale calibration.

Size of Test Box Enter measured values here... \ / v

7.9381n 100.79 %

Width
Width
Length 8.0311n 99.61%
Reset Scale Update Cancel
Enter actual Width Calculated Scale Click on Update
and Length values

77



¢ Click on Update and a prompt window will ask if you want to Apply Scale Adjustment. Click on Yes
and you'’ll be back in the Vinyl Spooler window. To verify the scaling, again click on Cutter Scale and
repeat the same steps. Make sure you leave your new scale factors in place by having the following
option marked:

Size of Test Box Current Scale

Width 7.8741n 100.25 % Leave this checked
Length 9.8431in

Reset Scale Use previous calibration

¢ Once your test rectangle is drawing at the correct size, the calibration process is complete.
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2.09 Test Cutting Flow Chart for the Skycut

Select a small test shape. You can use the built-in test on the Skycut. However, a shape with an internal path, such as a ring, works better

as it allows you to more easily check to see if the blade is cutting into the backing sheet or cutting mat.

Start with conservative Force and Speed.

Insert the blade holder as instructed in Section 2.01.3.
On the control panel: Set>Advance Mode, choose to End or to Left and enter a small distance, such as 0.5” or 10 mm to space each test.
Set origin in the lower right corner of the material.

1.
Perform the

Cut was clean!

test cut.

l

Cut was mostly clean but had some
tearing and/or crumpling

Scratched the surface;
did not cut through the
material.

Partial cut (cut through in some spots
but not in others)

Check cutting
mat*** for cut
lines.

Increase force by 10. If you've already repeated this
step several times, try setting Passes =2 (or higher
on dense materials). If doing test cut at control panel,
change Advance Mode: to Start so that a second
test cut will be in the same location.

Return to 1.

There are deep cut
lines in the mat.

There are no cut lines in
the mat or faint lines.

\_'

Increase force by 10 and
increase blade exposure by
~1/4 turn.

Return to 1.

Retract the blade
~1/8 -1/4 turn.
Returnto 1.

Try one or more of the following:

Decrease the force.
Make sure the mat is clean and sticky.
Try a different blade in case current
one is chipped.
Dry the material.

Returnto 1.

Check cutting
mat*** for cut

There are deep cut
lines in the mat.

Returnto 1.

Important! If a stuttering

sound occurs during a cut and/
or the mat begins skewing, slow
down the speed, lower the pres-
sure, and increase the number
of passes. This will allow the
blade to work its way through
the material versus being
forced.

Retract the blade a tiny bit.

lines.

*kk

There are no cut lines
or faint lines.

or backing sheet, such as with vinyl

If you have an intricate project, you may wish to repeat using a partial
section of the project. Otherwise you are done! Record your settings!

© 2018-2023 Sandy McCauley, All Rights Reserved
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2.10 Settings Form for Cutting Materials

Material Brand or

Material
EE— Source

Blade

Force

Speed

Blade
Offset

Passes

Other Comments

© 2009- 2023 Sandy McCauley, All Rights Reserved
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2.11 Suqggested Settings for Various Materials

IMPORTANT: These settings should be used for the initial test cut only. Adjustments may be necessary based
on the condition of the blade, variations in the material, humidity, condition of the cutting mat, blade tip height,
etc. Refer to Section 2.09 for a guide to adjusting settings for optimizing the test cut.

Note: Speed settings are based on the number in parentheses in the Cutter Control tab.

(0.5mm) (20 mil)

Material Type Material Brand/Source Blade |Passes | Force |Speed |Other Comments
Cardstock: light Light 65 Ib (~176 gsm) R 1 35 | 8
Recollections
Cardstock: medium  |Medium: Textured Bazzill R 1 40 8 [Blade fip ht= 40 Post It notes
Cardstock: heavy Accent Opaque 270 gsm (100 R 1 75 5
Ib cover)
g:)'(pboard: cereal | 018" (0.4 mm) B 1 50 | 5 |Alt2passesat40
Chipboard 0.022" (0.5 mm) B 2 75 5
Chipboard 0.03" (0.76mm) B 2 95 5
' ) Bleft | 3:on 175 0n 1 1:on Duplicated |mage- right side cyt/ half-blade
Chipboard 0.06" (1.5mm) R riaht! both both | boh |EXPOSUre: left side cut at required blade
19 exposure; Blade tip ht= 20 Post It notes
Cla Use a clay press (or pastry B 1 1" 10 Make sure pinch wheels will not cross over the
y machine) to make clay thin clay. Blade holder mounted on top of black seat
Copy Paper Mostany brand R 1 30 8
Fabric - Cork embroideryaarden.com B 2 40 5 Blade tip ht= 25 Post It notes; use an exfra sticky
mat and taped around edges. Brayered well.
~ 1.2 mm thick from Art of Extra sticky matw/ material upside down. (mirror
Faux Leath B 1
aux Leaher Fabric Folding (on Etsy) 50 6 imagem, as needed)
Faux Leather AOUXSEEM 1 mm (available B 9 50 8 !Extra sticky mat w/ material upside down. (mirror
on Amazon) imagem, as needed)
Foam - Plain 2mm B 2 25 10
Foam - Glitter Foamy - 2 mm R 2 15 10
Marietta Magnetics - 0.02"
Magnet (0.5mm) (20 mil) B 2 | %08
Magnet 0.035" (0.9mm) B 2 50 3 |Alt 1 passat85
Magnet Marietta Magnetics - 0.02 B 2 90 8
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Material Type Material Brand/Source Blade |Passes | Force |Speed [Other Comments

Tracing Paper Helix Vellum Paper R 1 30 8

Vinyl - Heat Transfer |Siser EasySubli - with the mat| R 1 30 8 |Cuton the mat

Vinyl - Heat Transfer Siser Glitter - Gold - No cutting R 9 35.40 7 2 passes mgkes it eas!er to weed, also slight
mat scrafch cutin the backing layer

Vinyl - Heat Transfer Siser Glitter - Gold - with the R 2 45.50 7 2 passes mgkes it eas!er to weed, also slight
mat scrafch cutin the backing layer

Vinyl - Wall (no maf) |Vinyl - Oracal 631 - yellow R 1 25 8

Vinyl - Wall (on mat)  |Vinyl - Oracal 631 - yellow R 1 30 8

Vinyl - Waterproof Papilio R 1 30 8

© 2009- 2023 Sandy McCauley, All Rights Reserved

e The latest updates to these settings can be found at this link.
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https://docs.google.com/spreadsheets/d/19oUdlb7VZXsrN0s062wjvpo_C7giT9fIdduq9AGodu4/edit?usp=sharing

3. Print And Cut (Contour Cut)

3.00 Quick Reference for Chapter 3

e How to calibrate the camera: Section 3.03

e How to set up a contour cut: Section 3.04

e How to adjust the camera calibration: Section 3.06.1

e How to add more registration marks: Section 3.08.1

e Troubleshooting inaccurate print and cut results: Section 3.06
e How to set up repeats: Section 3.07

e How to do a PNC from a USB flash drive file: Section 3.09

3.01 What Is a Print and Cut (PNC)?

e The print and cut process (also called PNC and contour cutting) involves printing an image from SignMaster
to any printer you own and then, with the aid of the Skycut’s camera, have the image or images cut out with
perfect precision. Below are three typical kinds of print and cut applications but there can be other kinds.

¢ Cuts along the actual borders of the printed image(s):

W Image is precisely cut along
(0 ‘ [ (9() < printed borders
S

¢  Cuts outside of the borders but follows the shape(s) of the printed image(s):

Image is cut in same shape
‘ () <— but offset from the printed
0 borders (contour cut)

¢ Cuts follow a different shape from that of the printed image(s):
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O
(o) o A custom shape is cut
(+ o) ‘ ‘ around the printed image.
L _|

3.02 What is a PNC Calibration?

In order to get precise PNC results, you must calibrate the camera. This is nothing more than letting the
Skycut know how far away the camera lens is located relative to the tip of the blade. Because the camera is
manually installed inside the blade carriage, the distance from the camera’s center to the tip of the blade will
vary from one Skycut to the next.

This calibration only needs to be done one time. If you have travelled with your Skycut or it's been bumped
fairly hard, you might want to run a test to make sure your calibration hasn’t changed. It’s also
recommended that you check your calibration after any firmware updates are installed.

The process, which is conducted through the control panel involves:

(1) Having the Skycut draw a test shape. At that point the camera takes a photo and displays it on the
control panel, along with a red + and a large blue dashed +.

(2) Aligning the red + with the center of the test shape display several times until the blue dashed + is
centered with the test shape.

3.03 Camera Calibration Procedure

1)

)

3)

(4)
()

You need the following items for this calibration:
¢ Sheet of paper

¢  Test pen that came with your Skycut

Insert the test pen into the Skycut. Place the sheet of paper into the Skycut. You can use the cutting mat to
hold the paper or insert the paper directly.

Move the test pen over the sheet of paper. IMPORTANT: For all camera applications, make sure the
starting origin is at least 3 inches from the right end cap so that the camera has room to move to the right to
take a photo.

Select Speed/Force and set SPEED to ~ 8 and FORCE to ~ 30. Click on Test to verify that a square is
clearly drawn. If it is too faint, increase FORCE as needed and repeat.

Move the pen an inch or two away from the test so that there is room for the calibration shape to be drawn.

On the Main Screen, press Set and then Camera:
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This is where photo
will be displayed

Two different screens based

on Align versus Adjust Magnify photo by 300%

Align is normal mode | «— Retake photo

| «— Change brightness of LED light

Adjust is calibrate mode

Update blue dashed + alignment

(6) Press Adjust to switch to calibrate mode. Press and hold the OK button for several seconds until it and the
arrows around it turn red:

1. Select Adjust

2. Press and hold OK 3. Release after
buttons turn red 4, Press Start

(7) Press Start. The test shape, which is a grid of 6 lines, will be drawn on the paper and the camera will move
over the test shape, take a photo, and display the photo on the control panel. If you cannot see the test
shape clearly, press the LED button once so that it reads LED 50% and press the Get PIC button. You
should see three items in the photo: the test shape that was drawn with the pen, a red +, and the blue

dashed +:
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Blue dashed +

Red +

Blue dashed + is also much
closer to the middle of the test
shape

(9) Press OK. A new photo will be taken and one of two things will happen:

Tap your finger here

Red + is now much closer to the
middle of the test shape

¢ Situation 1: The red + is so close to the center that the Skycut will now take over and find the true center
on its own. You will see the red + and the blue dashed + aligned in the center and the arrows (only) will
return to their blue color. Refer to the left side of the next screenshot.

¢ Situation 2: The red + and the blue dashed + are still not aligned and the arrows around the OK button
are still red. Refer to the right side of the next screenshot. You will need to tap the center again and

press OK. Continue, if needed, until the center is identified.

Everything is
aligned with
the center

Arrows are
blue again

Press Home

Situation 1

versus

Not quite aligned
— tap center again

Arrows are
still red

Situation 2
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(10) Once the alignment is in place and the arrows have turned blue, press the Home button and then press
Stop on the Main Screen to save the calibration and conclude the process:

* B @

ReCut uUsB

3.04 Performing a PNC in SignMaster

3.04.1 Summary of Steps

e Here are the typical steps when performing a PNC application:

0

Prepare the image(s) that will be printed which can include the following:
o Animported raster image such as a JPG or PNG or BMP file
o A vector image (either imported or designed in SignMaster) that will be printed but not cut

o Text that will be printed but not cut

Prepare the cut lines which can include:

o The resulting cut lines from tracing imported raster files. Refer to Section 5.01 for details on using
the Trace function in SignMaster.

o A contour cut around the outside of the traced image: Refer to Section 5.01.

o Any other vector shapes, either imported or designed in SignMaster: Refer to Section 5.02.

Print the project, after selecting reg mark properties, location of project on the page, and printer options.

Perform a test cut so that you know the best cut settings to use for the printed material. This test cut can
often be performed on the printout itself if there is room in the waste area of the project.

Perform the cutting process.

3.04.2 Step-by-Step Simple PNC Project

(1) While it's not a requirement, it can be helpful in designing if the Drawing Area dimensions match the
printout size you plan to use. For this tutorial, Letter size (8.5” x 11”) will be used. But you can use much
larger sizes, if you have the ability to print in those dimensions.

(2) To change the Drawing Area, click on the down arrow to open a drop-down menu with many page options
or just enter the dimensions directly:
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Click here to open
menu of page sizes

T e — 1 1 | N - } Or change the page
L4 11/11.000in 2 : : .
dimensions directly here
S s il
* E 3

(3) For a sample project, go to this link and download the zip. The project used in this tutorial is called Yellow
Ox PNC. Alternatively, Section 5.01 presents a tutorial on importing a graphic and adding a contour cut.
Note the contour cut around this image:

Blue line will be cut

_/but not printed

WO ‘

Yellow and black ox will
be printed but not cut

-
*

(4) Click on the Contour Cutting icon . and select Contour Cut Wizard. The following window opens:

Contour Cutting Wizard x
Output Options Print Options Mark Options Templates L8 o e o - P
Cutting Device ] Vet b By
g Marks: 7.713 in x 10.213 in
Select Automatic (¥ skvcuTvzd j v Spodler... o
ARMS (O Manual 3
[CJQR Code ]
~
O Automatic ARMS L-Shape 2068 @
Printing Device
. S ]
© Print Direct '3 EPSON ET-15000 Series | Properties
() Print as PDF ] =
. . O ‘ ]
Preview of prOJECt S o S
H ()S: BDE |-
with reg marks : ] >
Mark Position 0.000in 5 Build Contours .
18 Job Hame Yellow Ox PNC for UM |
o]
Tiled Copies Full width Get the maximum cutting area ] .
Practice Sheets 4
[C) Cut Insides First (] Advanced Options 3‘__
“w | Calibrate %W | ARMS Fractice Reset to Default B
. . ~\Wiew both {View Print only {View Cut only [ [)Save as PLT
Enable Page
Marks 5 > Page Marks. Skip Print oK

(5) First, verify that Automatic ARMS is selected which means the camera will automatically scan the
registration marks.

(6) Mark the Page Marks option which will place the registration marks near the outer edges of the printout.
Note that you can also skip this option and set the marks based on the cut lines instead. Refer to Section
3.08.3.

(7) Next, to verify “what will print” versus “what will cut”, click on the other tabs below the preview:
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https://drive.google.com/file/d/1cECETKrdKePCkAEXB46EYMF5xmuhiw1G/view

10,767 in
10,767 in

B N LN\

8.267 i 8.267 in

i, View Print only f\n'iew Cut only | \ () save as PLT View Cut only 0 Savé\is LT
Print-only preview Cut-only preview

(8) The following options are available for printing:

Printing Device

@ Print Direct |3 canon ixeg00series v Properties
() Print as PDF

(C)Save as Image

(") Save POF

¢ Print Direct — Select this option if you are printing directly from this window to your own printer. Note
that the printer menu and printer properties appear to the right when this option is selected.

¢ Print as PDF — Select this option to send the file to Adobe Reader to then print to your printer

¢ Save as Image — Select this option to export your printout as a JPG or TIFF file using the DPI resolution
of your choice

¢  Save PDF — Select this option to export your printout as a PDF file to be saved and printed using a
different computer/printer setup (such as taking to a professional printing company)

(9) Depending on the print option selected in Step (6), the print button below the Preview will vary. Assuming
you selected Print Direct, you'll see the option to Print. Click on it or click on the button in the same
location and then complete any popup window options as needed. Note that if you've already printed your
project, you will want to click on Skip instead:

Bin Click on Print. Note: the
wording on this button will
{View Print aniy Jview Cut orly | vary based on print option
Click on Skip if project / selected in Step (6)
is already printed — skip Print Cancel
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(10) Place the printout onto the cutting mat or load the printout directly if a cutting mat isn’t required. Note that
in SignMaster, a print and cut project is loaded “upside down” as shown in the following screenshot. On the
printout is a small arrow which is a reminder to load the printout so that the little arrow is facing towards you
as you are facing the Skycut:

HH HH Feed this direction into
I i Skycut
| T

Place printout this direction on mat or, O
if no mat is used, this direction as fed HH ‘
into Skycut i > @

| L™=y

! \\ Small arrow should

‘ : point downwards

(11) Load the mat and/or printout so that it is straight, relative to the cutter. The alignment doesn’t need to be
absolutely perfect but close enough that it will allow for a faster and, of course, successful detection by the
camera. Insert the blade holder and perform a test cut, as needed, adjusting the cut settings.

(12) Click on the Spooler and the Cut Options tab. If you want to send the cut settings from SignMaster, adjust
the Force and Speeds accordingly or select a Preset. Otherwise, if using the cut settings on the Skycut
control panel, turn these off. Click on Done after making any changes:

Click on Spooler to open the Vinyl Spooler window Make any necessary changes in this window
.CnntnurCutting Wizard ® Preview ¥ Cut Options 5 Connection T Calibration
Output Options  Print Options Mark Options Templates S SKYCUT: V24
Cutting Device Media Size
|3s SYCUT: V24 " Spocer... Media Width 24.803 in = dia
Media Length 0.000in =
() Manual

[Jcut in Strips

(®) Automatic ARMS L-Shape 20x%
Cutting Options

Printing Device Preset Mode: ~ Edit Presets
(®) Print Direct 21 Canon iX6800 series ~ Properties [ sace orrset - -
ade Offsel 0.35 Calibrate
() Print as POF a Calibrate

aninn

Overcut 1.00

() Save as Image
O save POF # Blade type Drag Knife (45deg) ~| Skycut Red Capped Bladé

Source Options - .
Additional Options

Selected Objects Mark Position 0.807in |5 Build Contours Tool Sdlect Default o | Primar
[] Clip to Page [Jcutting Force 55 =1
Include Full Bounds [+] Jab Name Yellow Ox PNC for UM [C]cutting Speed 400 8
Travel Speed (5) |250 =1
|:|Tiled Copies DFU.lwidlh Get the maximum cutting area) U ]
Cutting Options
Practice Sheets [] advance after piot Area Tests
[C] Cut Insides First [[] Advanced Options
| Calibrate G | ARMS Practice Reset to Default
' ! rea Te u Dane

Uncheck these options if settings

on control panel will be used Click on Done to
close this window

(13) Back in the Contour Cutting Wizard window, the Print button should now read Cut Now. Click on Cut
Now and a new Preview window opens which indicates the design should be facing downwards:
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Align Cutfile Wizard X

Select Orientation
Select the Orientation that matches the loaded meda

Detect Alignment Marks

Please Position the Cutter at the start point and Reset the Origin

[J Resume cutting from internal mark

!’f

Printout should be facing this way

Set blade holder over lower right reg mark

Origin shouid start as shown above.

)
Y7
X ¢=—=o
“\View both {View Print only [View Cut only / ® e ¢
ﬁkescaxe [ Metric Units Restart < Bac! Next > <——eme— Clle on NeXt

(14) Click on Next and the Skycut’s camera will now move over each registration mark and take a photo and
make an adjustment. Once it has read all four marks plus the first one a second time, it will proceed to cut
out the printed shapes.

(15) After testing out this process, be sure to check out other sections to understand additional options, such as:
Preparing a vector image for a PNC application — Section 3.05.2

Adjusting camera calibration settings, if needed — Section 3.06.1

How to set up a grid of repeats — Section 3.07

Adding additional registration marks to improve accuracy — Section 3.08

Performing a PNC using the USB flash drive — Section 3.09.1

S O

3.05 Preparing Designs for PNC Applications

3.05.1 Using Raster Images

e Use File>Import>File to open a raster image (JPG, BMP, TIFF, PNG, etc.) in SignMaster. To add a contour
cut around this image, there are two options:

¢ Add the contour while in the main SignMaster window — this process is covered in Section 5.01.

¢ Add the contour after entering the Contour Cut Wizard window by clicking on Build Contours:

Source Options
Selected Objects Mark Position 0057 2| | Buidcontours 4—— Click here
[ Clip to Page
Include Full Bounds [] Job Name Yellow 0o PNC
|:|T1len Copies |:| Full width Get the maximum cutting area

o Using Build Contours essentially takes you to the same Create Cut—Contour window and the
process is the same as presented in Section 5.01.

e The advantage of tracing images before entering the Contour Cut Wizard window is the ability to edit the
tracing and save the file with the tracing in place. An example of editing a trace is covered in Section 5.01.2.
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3.05.2 Using Vector Images

e You can design your own vector images in SignMaster using various design and vectorizing tools. You can
also directly import vector files in a variety of common file formats including: Al, DXF, EPS, PDF, PLT, and
SVG.

o While vector images are essentially ready-to-cut files, SignMaster will not apply them as contour cuts in print
and cut applications without having them assigned as such. Refer to Section 5.02 for instructions on how to
perform a contour cut using a vector image.

3.06 Inaccurate Cuts

e There are several reasons why your print and cut results may not be as accurate as you need:
¢ The calibration needs to be tweaked
¢ The contours around the printed image are not accurate

¢ The cut settings are too aggressive
e The following sections present solutions for each of these.

3.06.1 Tweaking the Calibration Values

e If you find your print and cut results are slightly off in the same direction with each cut, you can adjust the
values being used versus attempting to recalibrate from scratch.

e To do this, go back to an easy-to-cut material like copy paper and use a shape that has both horizontal and
vertical lines. This makes it easier to know if you need to adjust in the X (left-to-right) direction or in the Y

(up-and-down) direction. The arrow from SignMaster’s General Power Shapes “ is a good choice
because you need both vertical and horizontal lines for measurement.

o After performing the print and cut, use a mm ruler to measure how far away the cut lines are from the
printed lines. If you used an arrow, focus only on the horizontal and vertical lines, not the diagonal lines:

¢ In this example, let’s say the red cut line is about 0.5 mm too high and about 0.3 mm too far to the left.
Thus, you need the cut line to move down and to the right.

e On the control panel, change the Units to millimeters by going to Set>General Settings and choosing
millimeters, as was shown in Section 1.14.2.

e Goto Set>Camera and click on Adjust. Then click on Set to open the Adjustment window:
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2. Then press Set

1. Press Adjust

Current
adjustments
are set to 0.00

_)

:j‘);=0.00 mm .
EEE
=

ﬁ Auto Adjust

e Press and hold your finger over Ax and Ay for several seconds until the other X,Y buttons light up.

e One at atime adjust Ax and Ay by pressing the X+, X-, Y+, and/or Y- buttons in the direction(s) you need

the cut line to move.

4x=0.00 mm
4y=0.00 mm

ﬁ Auto Adjust

ax=-0.30 mm

ay=-0.50 mm .
=B E

m Auto Adjust .

Use these buttons to adjust the
Ax and Ay offsets to these

e Once the values are set, press the Home button to return to the Main Screen. Test again to verify the cut
line is better aligned with the printed shape.

e Important: You can also adjust calibration numbers after a cut has begun! These adjustments will only
apply for this particular cut but can be very useful in “saving a cut.” Refer to second part of Section 3.09.3

for instructions.

3.06.2 Inaccurate Tracings

¢ When tracing imported images, the resulting cut lines may not necessarily follow the original image,
especially in tight spots. This can result in tiny bits of white appearing, suggesting the PNC wasn’t accurate.
Zoom in on the image so that you can see the trace line following the outline of the image. Compare by

93



looking at the same spots where the cut didn’t follow the image perfectly. This could be the cause of the
inaccurate PNC. There are several ways of handling this situation:

¢

0
0
0

Retrace the imported image using a lower Smoothing setting (refer to Section 5.01). This will result in a

tighter fit around the original graphic.
Use the Node Editing Tools > to move the trace lines to more closely fit the original graphic.
Create an inset contour cut line to use for cutting instead of the original trace line.

Create a bleed by choosing Cutting Contour + Bleed in the Create Cut Contour window.

e Another possibility is that the contour cut line was inadvertently shifted from the graphic to be printed. So,
check to see if a misalignment may have occurred when you were moving or simply clicking on the design.

3.06.3 Incorrect Cut Settings

o |If a PNC is not precise and the cause is not the calibration nor the alignment of the trace lines, then go
through the following check list of other possible causes:

0

Try slowing down the speed. If the mat is moving numerous times, in and out of the cutter, a slight
shifting can occur, especially at high speeds. On the Skycut, try a speed of 7 or lower.

Verify that the pinch wheels are still centered over grit shafts beneath.

Make sure the blade isn’t over-extended which can cause it to cut too deeply and drag the cutting mat.

Make sure the bottom of the mat isn’t sticky and the pinch wheels and grit shafts are clean and not
sticky. Clean with a lint-free cloth and a small amount of isopropyl alcohol or Un-Du.

If the print and cut project contains numerous repeats, use additional registration marks so that
additional scans can occur during the cut. Refer to Section 3.08 for instructions.

3.07 Adding Repeats in Print and Cut Applications

(1) In the main SignMaster window, select the design and go Arrange>Tile Array Tools. The following panel
will open with settings for the number of repeats and the spacing between the repeats can be set:

i Step & Repeat and Array Tooks

Select Tile Array tab —— tiearay steprepeat circle Array

Quantity

Horizontal 1

Vertical 1

Al][4]r

Enter columns and
rows of repeats

1 Object

Inter-copy Spacing

Horizontal 0.000 in : Enter spacing between
Vertical 0.000 in z columns and rows

Options

(2) As you being increasing the Quantity and adjusting the Spacing, rectangles will appear representing the
repeats:
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i3 Step & Repeat and Array Tools

Tile Array  Step Repeat  Circle Array

Array size
tit:
Quentity = # of columns
Horizontal 3 =
Vertical 4 v‘\
. # of row
/ 12 Dbjects ofrows
Selected
image .
Repeats |y
appear as
em pty boxes Inter-copy Spacing
Horizontal 0.500 in =
= .
Vertical 120n 45— Spacing
Options
Preview
Apply

N

Click Apply to see
images

(3) To see the actual images, click on Apply if no further changes are required:

Tie Array: 3 x4

:
¥

&
i

¢
@

T

By
oy
By
oY
»
oy

3.08 Reqgistration Mark Settings

3.08.1 Adding Intermediate Registration Marks

e Continuing with the same project from the prior section, to access the registration mark options, click on the
Mark Options tab in the Contour Cutting Wizard window and note the following:
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Select Mark Options tab

Contour Cutting Wizard
Output Options Print Options Mark Options  Templates

Custom Mark Settings

This section allows you to specify the style of marks used in the detection process.
Generally, the more marks you use the more accurate the contour cutting wil be at the
expense of taking a little longer

Mote: Using larger marks increases the chance of detecting the marks

Space marks based on Add more marks

distance
\Mark Adjustment Method

(®) Set target mark spacing () Specify number of marks

Let required mark distance

Horizontal Mark Spacing 000.0 Reset

Vertical Mark Spacing 300.0 mm

¢ Set target mark spacing: use this option as a default or if you want to reduce the maximum spacing
allowed between marks, thus increasing the number of marks. For example, if Vertical Mark Spacing is
lowered to 100 mm, in this particular case, a new set of intermediary marks are added:

Custom Mark Settings d Yellow Ox PHNC
1 Marks: 7.973 in x 9.301 i
This section allows you to specify the style of marks used in the detection process. LIS TR Tz Gl

Generally, the more marks you use the more accurate the contour cutting will be at the e —
expense of taking a little longer ]
Note: Using larger marks increases the chance of detecting the marks -

Mark Adjustment Method ]
.l
(®) Set target mark spacing () Specify number of marks 9
- =
i =
Set required mark distance N g
w =
Horizontal Mark Spacing 1000.0mm (= Reset ]
Vertical Mark Spacing 100.0 mm =

/

Lower spacing to 100 mm

A new set of marks 8.267 in

are added

¢ Specify number of marks: use this option to force another set of marks to be added:
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d Yellow Ox PNC
] Marks: 7.973 in x 9.301 in

Custom Mark Settings

This section allows you to specify the style of marks used in the detection process.
Generally, the more marks you use the more accurate the contour cutting will be at the

expense of taking a little longer
Note: Using larger marks increases the chance of detecting the marks

Mark Adjustment Method

() Set target mark spacing (®) Specify number of marks

10.767 in

Extra Mark Options

Number of horizontal marks 1 S 3.9871n

Humber of vertical marks z = 3.1001n

f

Change from 1to 2

A new set of marks |
are added 3 |

o 8.267in

e With these intermediate marks added, they will be scanned, as well. Thus, in this example shown, the
bottom four marks will be scanned and the lower two shapes cut out. Then, the top set of four marks will be

read and upper two shapes cut out.

3.08.2 Reqistration Mark Types and Sizes

e The dropdown menu next to Automatic ARMS contains 9 options for the type and size of registration marks

that can be used:
Cutting Device

[ skveur vas ~]

(C) Manual
() QR Code

© Automatic ARMS

Printing Device
© Frint Direct
() Print as PDF

(0) Save as Image

(C) Save PDF

¢ Important: At the current time, only the options marked with an L (which is the right-angle type mark used
in the screenshots so far in this chapter) are applicable to current Skycut cutters:

L registration marks
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¢ Note the following description and size for the individual options in the menu:

¢ L-Shape: L marks that are 20 mm x 20 mm in size

¢ L-Shape 20x9: L marks that are also 20 mm x 20 mm in the four corners. Any intermediate registration

marks will be 20 mm x 9 mm in size:

Note that the
intermediate marks
will print over the
image!

L-Shape 20x9

¢ L-Shape 9x9: L marks that are 9 mm x 9 mm in size

¢ L-Multi: Identical to the L-Shape 20x9 marks but without the little arrow indicating which direction to

load the material.

¢ L-Multi+1, L-Multi+2, L-Multi+3: Same as L-Multi but with additional (1, 2, or 3) sets of reg marks
added. These options, however, do not currently work as expected. Instead of scanning AND cutting
one section at a time, all marks are read before any cutting begins. Thus, in most situations, you will

The registration

image

want to alternative methods for adding additional marks. Refer to Section 3.08.1.

marks are clear of the

e To change the distance of the reg marks from the boundaries of the printout, click on the Print Options tab
and under Page Mark Options, the distance from the page edges can be changed:

Contour Cutting Wizard

Output Options  Print Options  Mark Options Templates

Printing Positicn
Use design size and position
Use Page Marks

Advanced Position

Left Position 0.0 mm

Top Position 0.0 mm

Page Mark Margins

Change left and/or Left Margin 15.0 mm
top distance from Top Margin 10.0 mm
page edge

alv]| |[aw

Al |[a]»

A
4 >
v

Right Margin

Bottom Margin

3.08.3 Mark Position (Offset Distance from Design)

Center

10.0 mm

10.0 mm

Al |[a]»

bottom distance from

} Change right and/or
page edge

¢ Instead of having the reg marks positioned near the outer edges of the printout, you can elect to have them

positioned based on the cut line boundaries of the design. To do this, disable the Page Marks option and

then the Mark Position field will be editable:
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The reg marks have
moved closer to the
design

o] 67 in o
_-\View both fView Print only /\iew Cut only [ Save as PLT
Page Marks [ Skip ] [ Print vVersus
Page Marks
enabled

8.267 in
7-\V\'ew bnlh,{\hew Print only A\hew(ul Dnlyf’ [:]Savea.’- PLT
1| Page harks skip print
Page Marks
disabled

You will also then observe that the Mark Position field can now be edited. However, you also need to make

sure marks are not too close to anything printed so that the camera doesn’t incorrectly attempt to scan the

image instead of a registration mark:

Source Options

Selected Objects Mark Position 15.0mm 5 Build Contours

[ Clip to Page \ D

istance of the marks from the

@ Job Name Yellow Ox PNC for UM outermost shapes

[C) Tiled Copies (] Full width (Get the maximum cutting area)

Mark Position = 15 mm Mark Position =10 mm

Mark Position =5 mm

You can see the movement of the marks towards the image as the Mark Position is decreased. Because of

the shape of the ox, this shouldn’t be an issue with the location of t

printed image. However, if a design is more rectangular, such as a wine bottle label, then it is much easier

to see that it could cause issues if the Mark Position is too small:

he registration marks relative to the
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Mark Position =10 mm Mark Position =5 mm Mark Position =2 mm
Will work Should work Will not work

3.09 PNC from USB Flash Drive

e To perform a print and cut project from the control panel, first perform Steps (1) — (11) from Section 3.04.2.
However, before clicking on Done to close the Vinyl Spooler window, click on the Connection tab and
change the Port to U-Disk from the drop-down menu. Then click on Done:

#F Preview t Cut Options = Connection g[ZF Calibration

Current Vinyl Cutter (Plotter) SeleCt Connectl on ta.b
TF Current Cutter | SKYCUT V24 -
U_Disk Remave + Add
Connection Method
Port Type 4 Windows Port w @ Help
Settings
o OFort U_Disk ~ — Select U_Disk

& (O Printer

Click on Done

e Back in the Contour Cutting Wizard window, proceed as before by clicking on Cut and the same Preview
window opens and again indicates the design should be facing downwards:
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Align Cutfile Wizard X

Select Orientation
Select the Orientation that matches the loaded meda

Detect Aignment Marks

Please Position the Cutter at the start point and Reset the Origin

[[JResume cutting from internal mark

Py

Origin shouid start as shovn above.

“\View both {View Print only /View Cut only | ® 06
=
0, Rescale [ metric Units Restart < Back Next > Cancet

Printout should be facing this way

<4—— Click on Next

Click on Next and the following window will open where you can save the job as a PLT file on a USB flash

drive inserted into a port on your computer:

. ® SavePitFile *
Select the appropriate |
drive —————— Savein: | USBDISK() v @ & > @ {
* Mame - Date modified Type
_ System Volume Information 7/18/2014 8:52 AM  File folder
uickiaceess [ 1 inch Circle.plt 6/23/20182:07PM  PLT File
|:| 1inch Ring Test Shape.plt 6/28/2018 :08 PM  PLT File
- ﬂArrowTest.pIt T18/2018 1:19PM PLT File
Desktop |:| Favorite Flourish.plt 6/28/2018 207 PM  PLT File
- |:| Favorite Flower.plt 6/28/2018 208 PM  PLT File
[ | |:| Owl PMNC.plt 6/28/2018 2:24 PM PLT File
Libraries |:| State of Arizona.plt 6/28/2018 :08 PM  PLT File
|:|Test Calibration.plt 6/21/2018 412 PM  PLT File
Q |:|Test of Origin Point.plt 6/28/20182:06 PM  PLTFile |
This PC |:|Test Settings.plt 6/13/2018 1:30PM  PLT File
@ < >
MNetwork )
Name the file File name: [Vellow Ox PNC ~| [ sae €}—— Click on Save
Save as type: Pit File (*plt) w Cancel

On the Skycut’s control panel, set the Force and Speed, if you elected not to have them activated in the

Vinyl Spooler window in Step 11 in Section 3.04.2.

Go to Set>Camera. With Align selected, press Set and the following window will open:
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2. Then press Set

1. Align should . . - -

be red Mark Size:

>0.78in  >03%in
. >0.1%in

Auto Mark Check
ﬁ Inverse AutoMark box

¢ Verify that AutoMark box is checked. Then click on Home.

¢ Insert the flash drive into the right side of the Skycut and use the instructions in Section 1.12.3 to open the
file into the Skycut:

File name should 2 Yellow Ox PNC.plt
appear here

I& r r.] ‘Ik' -

Press Start Cut -

e Click on Start Cut and the marks will be scanned by the camera and the shapes cut out.
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4. Accessory Tools

4.00 Quick Reference for Chapter 4

e How to draw with the test pen and cut around the drawing: Section 4.01.1
e How to score and cut a fold-up project: Section 4.02.2
e How to emboss cardstock: Section 4.02.3

e How to engrave a metal tag: Section 4.03.1

4.01 Drawing with the Test Pen

e With the Skycut, you can draw shapes and lettering with the test pen.

o If you wish to fill (i.e., color in) a shape, select the shape and click on the Plugins icon W Pugns and select

Engraving Module. Refer to Section 5.03 for instructions on how to adjust settings to create a line fill.

e Do not have the pen positioned too low in the blade holder seat or the tip of the pen could drag across the
paper when moving from one shape to the next. Thus, use the 35 Post-It note method presented in Section
2.01.3.

e Make sure your shapes will not be drawn where any of the pinch wheels travel over the material. Otherwise,
the ink might smear.

4.01.1 Draw and Cut

e A draw-and-cut application involves using the test pen to draw shapes and then using the blade holder to
cut them out. This rest of this section covers the process.

¢ In the following example, a design is selected from General Clipart and sized for the project. Then a
contour is added using the instructions in Section 5.01.:

¢ Note that the contour color (blue) differs from the design’s Fill color (black). This is important so that the
draw and cut can occur separately, providing the opportunity to change out tools.

e Click on the Cut, Plot, & Engrave Tools icon and select Send to Cutter. In the Send to be Cut window,
mark the option for Assign Tools by Color. You will then see the two colors, blue and black, appear in the
Cutting Tool Presets list:
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General Options
[]separate by Color

[ ] Registration Marks Assign Tools by Color
Cutting Tool Presets
. Mark this
Calor Hame Cutting Preset Blade Type Blade Preset .
Colors used in option
¢ Il (Contour Cut Cal...
roject
Proj M Biack
~ Edit % Reset  []include Color

The layers will be processed in the order shown. However, because it makes more sense to draw first and
cut second, the blue layer will be moved down. This is done by selecting the blue layer and clicking on the
down arrow below:

Cutting Tool Presets

Color Mame Cutting Preset Blade Type Blade Preset
Select b N _—
elect blue
I Black

layer

Click the down

/ arrow

w Edit % Reset [ Include Color

The cut settings for each layer now need to be assigned. If settings have already been entered and saved
as Presets, you only need to select from the Preset menu:

Cutting Tool Presets

Color Hame Cutting Preset Blade Type Blade Preset
M Eack

Select black

|ayer I (Contour Cut Col...

Click the down arrow to
open Presets menu

> . Edit % Reset  []Include Color

Cut Mode (Tool 0)(Head L)
Cut Mode (Tool 1)(Head R)
Fold Tool (Tool 0)(Head L)
Select Pen Mode

(7)[Pen Mode (Tool 1)(Head R)

Georgia Pacific 110 b covg
1

()]

e

If you need to enter new settings, which will be done for the contour cut (blue) layer, select that layer and
click on Edit and the following window opens:
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General Cutter Control Settings Tiling/Pal

Vinyl Cutter (Plotter)
Select Model

Media Width

Job Hame

General Opticns

Cutting Tool Presets

Color Name

M Biack

/v Il (Contour Cut Col...

1. Select blue
layer

2. Click on

SKYCUT V24

24803 in

Draw and Cut
[ Rotate
[ mirror
] Registration

Cutting Preset
Pen Mode (Tool 0

Edit

Edit

Preset Cutting Modes
Preset Mode: ~
Cutting Options
Blade Preset ~
Elade type Drag Knife (45deg) w [ g
@ Blade Offset 0.35 : L !
J
Overcut 1.00 = ’

Additional Optians L 3. Enter all settings to
Tool Select Defaut v be applied for this cut
8 Cutting Force 45 = g
@ CuttingSpeed  (7) |350 =& mm/s
B Travel Speed 7) |350 =15 mm/s

Cutting Options (selected contours) Info
© Hone - Default i These aptions can be applied to
(©) Multi-cut (thick media) \) selected contour colors: (in main
(") Dash cut gn program). You can also

() Multi Fold/Crease Lines TR A=as

(_) Thick Sheet (lift blade at corners)

Apply < Eaneet

4. Click on Apply

¢ IMPORTANT: Note that this window does not allow you to save the settings as a new Preset. Thus, if
you will be cutting this material often, you might prefer to set up a preset for it using the instructions in

Section 2.04.2.

e After clicking on Apply, you will see that both colors now have settings assigned. Because the blue layer is
still selected, its settings show along the bottom:

Blue layer is selected

Assigned settings
for blue layer

Both layers have settings assigned

Cutting Tool Presets
Color Mame Cutting Preset Blade Type Blade Preset
Il Elack Pen Mode (Tool O){Head L) Pen Tool
—>» | I (Contour Cut Col... Custom: {0.35, 1.0) Drag Knife (45...
~ Edit Reset [ Include Color
—p, Blade: 0,35, Force: 45, Speed: 7, Drag Knife (45deg), Tool="Tool

e Load the material into the Skycut. Click on Cut Now and you will be prompted to load the Pen Tool:
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) 1 sl

Load blade tool *

—Please insert the following blade tool——— 1 CF, Width: 156,142 10n

This prompt —
window opens

Pen Tool

6.024 in
Primary cutting head
2. Afterloading test | oK | | s |
pen, click on OK
il
T-D & 3| ¢ ®0 o (|

B TN BT

1. Click on Cut Now

Load the test pen into the Skycut, click on OK, and the design will begin drawing. The second prompt
window will immediately open:

Load blade tool X

~Please insert the folowing blade tool————

L

Drag Knife (45deg)

Primary cutting head

ok || se |

As soon as the drawing process has ended, load the blade holder into the Skycut and proceed with the
contour cut by clicking on OK in the prior window. Once completed, click on Done to close the Send to be
Cut window.
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4.02 Embossing and Scoring

4.02.1 General Info on Embossing

e The Skycut embossing tool has two different sized embossing heads. The smaller one is recommended
when scoring cardstock for fold-up projects, such as pop-up cards, gift bags, and small boxes. Either head
can be used for embossing shapes.

J——

e When embossing cardstock, it is recommended that a soft material be place beneath the paper or cardstock
to allow a deeper impression to be made. One excellent material to use is non-slip shelf liner. Other
materials which can be used include rhinestone rubber, craft foam, and felt. Make sure the material is well
adhered to the mat (tape it down, if necessary). Then tape your paper or cardstock to the top of this
material.

e When using the embossing tool for scoring fold-up projects, the paper or cardstock can be applied directly to
the mat, just as you do for cutting. This makes it much simpler when you need to score and then
immediately cut. Because the scoring may not be as deep on the underside of the paper or cardstock as the
top side, fold all score lines (valley and mountain) forward to establish the fold on both sides. Then flip over
and fold any mountain folds the opposite way. This especially works well on pop-up cards.

e Make sure you do some tests first to get the best settings for the scoring or embossing you need. For
scoring cardstock, this typically involves a higher force (~75). If you have a soft material beneath your
paper/cardstock, then a lower force will be used. As with the test pen, use the 35 Post-It note method
presented in Section 2.01.3 to install the embosser into the Skycut.

4.02.2 Score and Cut Project

e When a project involves both scoring and cutting, a process similar to what was used in Section 4.01.1 will
be followed. Because scoring normally requires multiple passes in order to get acceptable folds an
additional setting is required. There are other settings of interest that can also apply.

e In this tutorial, a fold up box project will be used as a typical example. This small box file is provided in the
zip file available here.

e Always make sure the project is organized so that you can easily select the score lines and the cut lines
separately. Click on the Objects tab on the Page Thumbnail Viewer and verify that the project is
organized as such. In this example, the score lines have been grouped together and the cut layer is just a
single object:
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Pages Objects

“3 Zoom

Cut lines are on one layer ——»p

£y Curve, (35 Nodes) (1)

Score lines are on another layer ——»

£y Curve [x 9] (18 Nodes.) (2)

o After following the instructions from Section 4.01.1 to arrange the layers so that the score layer will be
conducted first, select that layer and click on the Edit option to open the following:

General Cutter Control Settings Tiling/FPanels

Vinyl Cutter (Plotter)

Select Model SKYCUT V24
Media Width 24803 in |
Job Name Small BoxTest Save

[ Rotate

| Mirror

General Options

| Registration Marks

Cutting Tool Presets

Color Name Cutting Preset
M Biack

/ Golden Yellow|020

1. Select black
layer

2. Click on
Ed|t # Edit

SKYCUTV24

Preset Cutting Modes

Preset Mode:

Cutting Options

Blade Preset Fold Tool

Blade type Fold/Crease Tool
[ Blade Offset

Overcut

Additional Options

Tool Select Tool 0

@ Cutting Force 70
@ CuttingSpeed  (6) [300
[ Travel Speed (5} |250

Cutting Options (selected contours)
(O) Nene - Default
() Muiti-cut (thick media)
(O Dash cut
© Muiti Fold/Crease Lines
(O Thick Sheet (lift blade at corners)

Al e[l al[e

mm/s

g || e ||

Fold/Crease Options

Line Gty

Spacing

make the selection of the settings much faster. Refer to Section 2.04.2.

z

mm/s

2

|0.100

e | {mmy)

L_ 3. Enter all settings to be
applied for the scoring
process

4. Make additional
changes (Refer to
Section 2.06.5)

5. Click on Apply

Note that if you will be performing score and cut projects regularly, setting up a Preset for your material will

Load the material into the Skycut and load the creasing tool with the small end downwards into the Skycut.

Move the tool to an appropriate origin. Click on Cut Now and you will be prompted to insert the tool:
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Load blade tool X

Please insert the following blade took

Fold/Crease Tool

Click on OK and the scoring process will occur. A second prompt will advise you to insert the blade holder
which should done after the scoring is completed:

Please insert the following blade tool

Drag Knife (45deg)

oK Skip

e Click on OK and the cut lines will be made.

4.02.3 Embossing Paper or Cardstock

When embossing paper or cardstock, it is recommended that you use an Outline effect to create several
very small outlines at a thickness of, say, 0.01” (0.25 mm). These tiny offset lines will then produce a slightly

thicker overall outline of your shapes. This works better than line-filled embossing which can stress the
cardstock and cause wrinkling. Here are the steps:

¢ Create the shape you wish to emboss. In this example, the number 25 is used:

-

¢ Select the shape and click on the Plugins icon W Figns and select Outlining Module. The following
window opens:
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o Create Qutline 4

] . 5 8 8 El

1 ZoomToAl Zoomin  Zoom Out View Mode

Outline: 0.0101n (0 %) Create Outline

Qutline Options

Corner Style
outine (3
cutine Set Size to 0.01”

Keep Holes

Reset

Qutput Options

D Use a Contour Cut (Dashed Qutline)

Use a Fill Color (Sotic) [N -

Images & Effects Options

[ include Images

[ include Effects

Click on Accept

Accept ‘(

¢ After clicking on Accept, use the Objects panel to select the new outline layer and repeat the process
to add a second outline. Now you have three versions of the shape, each one slightly outset from the
other. Thus, when using the embossing tool, this will result in a thicker outline made of this shape.

¢ Important: don't forget to mark the Mirror option in the Send to be Cut window (or apply
Arrange>Mirror & Rotate>Mirror Horizontally) so that when you flip over the cardstock after
embossing, the design will “read correctly.”

4.03 Scratch Engraving

The Skycut engraving tool can be used to engrave vellum, foils, acrylic, and most metals, including trophy
labels, dog tags, and jewelry charms.

On softer metals, you may not want the engraving tip too far above the metal as it can leave pock marks
when it drops to start engraving. If possible, test on scraps first.

To design an engraving fill pattern, use the Engraving Module. Refer to Section 5.03

4.03.1 Engraving a Metal Tag

¢ When engraving items that are already cut (such as metal tags, trophy plates, charms, etc.), it's very
important to have precise alignment before proceeding. Therefore, the camera on the Skycut will be used to
set the origin for engraving. If you haven't already calibrated the camera, go to Section 3.03.

e The following is a list of the items you’ll need for this kind of an application:
¢ The item to be engraved
¢ The Skycut engraving tool

¢ Double sided tape to secure the item to the cutting mat. Thermo-web is perfect for this.
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Create a replica of the item to be engraved:

Replica of tag created
using two circles

¢ Ifit's not a shape that can easily be recreated in SignMaster, then trace it onto paper:

¢ Scan or photograph the trace and use the instructions in Section 5.01 to import the scan and create a
contour of the heart:

Imported scan Tracing from Create
Contour Cut window

IMPORTANT: Carefully measure the actual tag and compare it to the dimensions of the contour. Adjust the
size of the contour if needed.

Create the design. In this case both text and a vector shape of a bone are added:

Because a filled engraving is desired, select the text and the bone shape and use the Engraving Module to
fill the design with lines. Details on this function are presented in Section 5.03.

Nikk

To arrange the design in the bottom corner of the Page, click on Snap in the middle taskbar and select
Page:
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Snap *

Grid

Guides

2

Objects

Mark Page —_’ v Page

All

e With both the heart and the design selected, drag to the lower right corner until it snaps to the right and
bottom sides of the Page / Drawing Area (Note: to better illustrate placement on the page and later in the
Preview, the design has been made much larger. In reality the design is only about an inch in size):

Nikki |

INTANT |

| > S_nap the design to the lower
right corner of the page

.

e Select only the design and not the heart tag shape. In the Send to be Cut window, mark the option for
Absolute (position) so that the design will be positioned the same distance from the origin as it is from the
corner of the Page / Drawing Area. Also, verify that Assign Tools by Color is not marked:

Check Absolute (position)

SKYCUT W24, 24.803 in

Rotate ] Advance After Flot I Black Color (1/1)

Mirror B Absolute (position)
[[J Use Top Left Origin

General Options

[ Registration Marks [ Assign Tooks by Color

[ Auto Speed-Weed [ Auto Weed-Box
Verify Assign Tools by Design is in same location
Color is not checked as on the Page

e On the Cutter Control tab, uncheck Blade Offset as it's not needed when using the engraving tool:

General Cutter Control  Settings

Uncheck Blade Offset  cutter Settings

T [] Blade Offset 0.40 = Passes |1 g

[[] Cut holes first Drag kKnife (45deg) - Skycut

e On the control panel, click on the Speed/Force icon and enter a Speed of 10 and a Force of 40 for the
engraving. Note that with your own testing, you may need to alter these settings.
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e The metal tag needs to be very firmly attached to the cutting mat. Place strips of double-sided tape onto the
mat, where the tag will be mounted:

=] |

Double sided tape is placed on the
mat to cover the size of the tag (note:
the pink liner hasn’t yet been removed
from the top of the tape)

¢ When placing the tag onto the mat, align the rightmost side of the tag with a vertical grid line and the
bottommost side of the tag with a horizontal grid line. The intersection of the two gridlines will be the origin
for the engraving process:

Align the tag with the grid

e ‘ lines on the mat

\ The origin will be set at this intersection

e Load the mat into the Skycut and be very precise in alignment by using the ruler to make sure the mat is
perfectly straight:

.
,
4

- .

<+—— Align the mat with the ruler

N PR S—

e Load the engraver into the Skycut using ~30 Post-It notes (or sheets of copy paper), making sure the notes
are on top of the tag.

e Move the cutting head so that the engraver tip is over the intersection of the two grid lines bounding the tag.
Then use the camera instructions in Section 2.05.1 to set the origin even more precisely by getting the blue
dashed + in the middle of the grid intersection:

- |

S Blue dashed lines cross at

grid intersection

e After clicking on Home, press down on the engraver and verify, once more, that the correct grid intersection
was used. Back in SignMaster, click on Cut Now and the engraving process will be carried out.:
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4.04 Settings Form for Accessory Tools

o ) Speed #
Application/iviaterial ool Toree | D) ouriace vther Lomments
Application/Material Tool Force cutU Passes Surface Other Comments

© 2009- 2022 Sandy McCauley, All Rights Reserved
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5. SignMaster Functions of Interest

5.00 Quick Reference for Chapter 5

e How to add a contour cut: Section 5.01
e How to node edit a contour: Section 5.01.2
e How to add a contour cut to a vector image: Section 5.02

e How to fill a design with engraving lines: Section 5.03

5.01 Adding a Contour Cut Line to an Imported Raster Image

e Graphics such as JPG, PNG, and BMP files are often used for print and cut (contour cut) applications.
Because these types of files are raster images (versus vector images), the images must be traced. This is
done through a process called vectorization.

5.01.1 Step-by-Step Tracing Process

e The following steps are a sample tutorial using the Create Contour Cut feature in SignMaster:

(1) For this project, go to this link. After extracting, you will find several images that can be used as easy
samples for tracing.

(2) To import a graphic file, go to File>Import>File and select the graphic to be traced. Left click anywhere
in the Drawing Area to place the image:

@

-
-

(3) With the graphic selected, click on the Contour Cutting icon »® and select Create Cut Contour. A
popup window will open and you will respond Yes:

Confirm

Images detected, do you wish to incude their auto-traced
contours?

(4) The Image Contour Tracer window displays the various settings available for adding a cut line to the
graphic:
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2 Image Contour Tracer u] X
File Edit View

Image: 528 x 598 pixels (Has Mask)

Preview Settings
<
S Opacity < > 150
2 =
Trace Settings-
Tolerance 18
A
< >
Use Image Mask
[] Low Quality (Fast) [/ Tight trace
[] Edit image mask
Cantour Options:
Smoothing 505
< >
Min Size 23
< >
Keep Holes Rebuild
Click here to trace at
current settings
v
'\ Original /i Composite jMask/Curves | < > & Trace Cancel

(5) Without making any changes, click on the Trace button to get a preliminary trace which will indicate
which settings, if any, need adjustment. The blue line indicates what will cut based on the default
settings shown:

(\//—\N\/ﬁ
/ ' \‘\ Carefully check the blue cut line:
£ ¢ Are all needed parts traced?

" ¢ |strace line a tight enough
| fit?

(6) To see the trace line a little more clearly, adjust the Opacity setting at the top. If the “fit” isn’t tight
enough, decrease the Smoothing setting. After making changes, click Retrace to return to the original
tracing window and then click on Trace again:

Increase Opacity to better see blue trace line

598 pixels (Has Mask)
Preview Settings

Opacity £ > M

Decrease Smoothing

fa .y ) » +
8 L g oo Options for a tighter trace line
P . Smoothing 0%
P N "

A N < >
— ‘__.---""" Min Size 2 : .
y Option to trace internal
F £ > .
parts if needed. Refer to
/ ] Keep Hotes —— Section 5.01.2.
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(7) After making any changes, click on Retrace at the bottom of the screen. On the other hand, if you are
happy with the trace results, click on Apply:

| |
I\ Ill‘l
\ /
N /
\\
A A Click on Apply if satisfied
S v with existing trace
/ \
" )
I\ /"_\-\\ /
v
\Original:l\CDmpnsile}(Maskaurves/ £ > & Retrace Apply Cancel

Click on Retrace to /

adjust to new settings

(8) If you selected Retrace, a Composite view of the results will appear where blue indicates the part that
will be cut out and red indicates the waste material. You can go back to seeing the prior view by
clicking on the Original tab at the bottom. Click on Trace to apply the new settings.

Image: 528 x 598 pixels (Has Mask)

Preview Settings

Opacity < >
Trace Settings
Tolerance a7
A
< >

Use Image Mask
[ Low Quality (Fast) Tight trace
[ Ecit image mask

Contour Options-

Smoothing 15%
< >
Min Size 2
< >
Keep Holes Rebuild
Click on Trace
Original k(ompﬂmle fMask/Curves < > & Trace ‘Cancel
Alternate viewing
options

(9) After clicking on Apply, a new group of settings appear, giving you additional options such as:
Whether the cut line is continuous or perforated

Whether the cut line fits the image tightly, or is offset a distance or inset a distance
Whether internal cut paths should be removed

S O O

The cornering shape of the contour cut (rounded, beveled, mitered, etc.)
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o Create Cut-Contour

I—‘\ N 5 “ D

iH| ZoomToAMl Zoomin Zoom Out View Mode

Outine: 0.042in (1 %)

Create Contour Cut (Outline)

(® Build Contours (O Build Boxes
() Cutting Grid
Contour Type

‘Cutting Contour ~

Outline Optians

Outline (Units) 0.042 in :

[[] pashed Lines

Keep Holes

Reset

Images & Effects Options

Incluge Images Vectorize
[ include Effects

Accept Cancel

Contour type options: use
these settings

Contour shape options

Original image options

Click on Accept when done

¢ Choose a Corner Style, as desired. For the Outline % or Outline Units (size), note the following:

o Setto 0 if the cut line should align with the edges of the printed image

o Set to a positive number for a contour cut around the outside of the printed image

o Set to a negative number (normally very small) to cut slightly inside the printed image

(10) Click on Accept after making any changes and you will be returned to the Drawing Area. If you click
on the Objects tab on the Page Thumbnail Viewer, you will now see both the original image and the

contour cutline:

Pages Objects

A

5 Zeom

@

=] Masked Image (528 x 598) (1)

£ Curve, (87 Nodes) (2)

e To print and cut this type of design, refer back to Sections 3.03 and 3.04.
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5.01.2 Editing a Trace

e Occasionally you may find a need to edit the tracing/contour cut created. This section presents two
examples.

e Contour cut doesn't fit the original graphic in certain spots

¢ In the following example, the Cartoon Owl image will be used:

¢ During the process of tracing, it was found that the bottoms of the owl’s feet weren’t rounded like in the
original image. Even trying different adjustments to Smoothing didn’t result in the desired fit. Note that
a slight inline was applied to improve the accuracy of the fit but the bottom of the feet still need

tweaking:

Trace line is flat along the bottom of owl’s feet

¢ With the trace line selected, click on the Node Edit Tools icon » and the nodes making up the path
of the cut will appear. Drag nodes, as needed, so that curves are formed:

Drag nodes to create curves

e Contour cut contains paths you want deleted

¢ In the following example, a crab cartoon from Doodle Dragon Studios is traced:

Y
(U

Also needed is a trace of
this area between the eyes
and the body

An outside trace is
needed e

¢ The issue in this example is that the space below the eyes should be cut out but not other internal
shapes, such as the pupils of the eyes. Note the difference in what will be cut between marking and not
marking the Keep Holes option in the Create Cut-Contour window:
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Area below eyes is traced but so
are the inner parts of the eyes

Keep Holes

smootning

Min Size

[ Keep Holes

1k

checked

=

versus

No inner paths at all

Smoothing

Keep Holes not
checked

¢ The first option, Keep Holes, needs to be selected so that the area beneath the eyes is traced. After
accepting the trace, click on the Objects tab on the Page Thumbnail Viewer and hide the original
graphic. You will now only see the contour in the Drawing Area:

Select this layer and

click on Hide icon

Fages Objects

pc 4

-

i

. | Zoom

&% Curve [x 5] (1068 Nodes.) (2}

=

¢ Select the contour and go to Curves>Break Apart. The individual paths will now be separate layers on
the Objects tab and you can delete each one that is not needed:

Delete these
three layers

Fages Objects

LXT | % Btom

‘| Image (1200 x 883) (1)

£ Curve, (33 Nodes) (2)

£y Curve, (38 Nodes) (3)

£ Curve, (146 Nodes) (4)

£ Curve, (51 Nodes) (5)

£ Curve, (801 Nodes) (8)

Path below eyes is
part of the contour cut

Paths inside of the
eyes are gone

120



5.02 Adding a Contour Cut to a Vector Image

e As mentioned in Section 3.05.2, vector images require a contour cut assignment in print and cut
applications. For example, the following Batman SVG file is imported into SignMaster and then the Contour
Cut Wizard window is opened. Note that comparing the View Print only preview with the View Cut only
preview indicates that the vector file is ready to print but there’s no cut line for the design:

804 in
804 in

8.268 in 8.264 in

:\VlewPhntonly i View Cut only | 1, View Print only ) View Cut only
What will print What will cut Option to add contour cut

e There are two situations to consider:
¢ A contour cut will be added to follow the printed design (Section 5.02.1)
¢ A contour cut will be added and it will be offset from the printed design (Section 5.02.2)

5.02.1 Contour Cut Which Follows the Printed Design

e Upon importing the SVG file, open the Objects tab of the Page Thumbnail Viewer to display the various
shapes in the file:

rages  Objects ——————— Click the Objects tab

Click this blue__y «|  4ns 1
“ “y [Zoom

arrow

[

3 Group (Batman head PNC.

n 4 All of the shapes
Bl éi appear in a list £ Curve, (38 Nodes) (2)

. &y Curve, (182 Nodes) (3)
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From the Objects list, click on the shape which represents the contour cut line you wish to use. In this

example, it is the black shadow layer:

Pages Objects

~ =1
> ¥ | 5 [Flicom

A

L} Group (Batman head PNC.

Select this layer —»

£ Curve, (39 Nodes) (2)

L~d

With that layer selected, go to Edit>Duplicate. A new layer will appear at the bottom at the Objects list and,

thus, will now be arranged on top of the project:

This new layer will also be selected. To assign it as the contour cut, click on the Custom Fill icon
that is located on the Palette and select Cut Contour from the drop-down menu:

A Tooks Jojects A Tooks

) ¥ |9 Awm | o8 | W

* ~ *

Hilg, = Eh
Click here ————» . Ve

i Cut Contosr «———  Select Cut Contour

| |
— Fold Contour
. =
1] Perf Contour

[ ] &
Base Color (white)
| s -
0l Registration Color
.. == ( Reverse Fill
Wireframe Fill
-= ’ Custom Dashed Lines

R

This newly assigned contour cut layer is given an invisible fill color and will no longer appear on top of the

imported project.

£ Curve, (39 Nodes) (19)

If you now go to the Contour Cut Wizard, you can verify that this new cut layer exists on the View Cut

Only tab:
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10.685 in

8in

View Print only hView Cut only

rks T Skip Print Cancel

What will cut

5.02.2 Contour Cut Which Is Offset from the Printed Design

Contour cut layer
now appears

e This section presents the method to be used when the contour cut is not one of the existing vector shapes.
While this section accesses the Create Cut-Contour window from within the Contour Cut Wizard window,
note that the same process can be applied by adding the contour from the main screen as was done in
Section 5.01 (i.e. select shape and go to Contour Cutting>Create Cut Contour).

offers the option to add one using the Build button below the preview.

[ ]

9.804 in

8.264 in

2 [View Print only }View Cut only

What will cut

¢ Clicking on Build opens the Create Cut—Contour window:

In the earlier screenshot, SignMaster recognizes there is no contour to cut on the View Cut only tab and

Option to add contour cut
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Q

12

/ Click on View Mode to add the Outline preview

o

{ X
Zoom To Al Zoom In Zoom Out View Mode
Qutline: 0.000n (0 %) OQutline: 0,000 in (0 %) / Create Contour Cut (Outine)
(@) Build Contours () Build Boxes. .
O Cutting ori Use these options

Conteur Type

Cutting Contour ~

Select a Corner Style

Qutline Options

e Keep at O for cut line
outine } to follow print line or...
Outline (Units) 0.000 in :

o n‘“ *n # Increase to add a

Clkess Haes contour cut or...

Reset Decrease to add an

inset cut

Images & Effects Options
[include Images

[Jinclude Effects

Click on Accept when done

e |

Corner Style: Usually select either Round or Sharp depending on the nature of the original vector
and your desired contour

Outline (%) or Outline (Units): Enter either a percentage or the actual size for the outline. In the
prior screenshot, leaving the Outline at 0 results in the contour being the same as the original
outside vector line. This would result in the same contour cut as was created in the prior Section
5.02.1. For an outset cut around the printed image, increase Outline to the desired size. For in inset
or inline cut, decrease Outline slightly so that it's a negative number:

Outline is set to 1/8 (0.125) inch:

ine: 0.125in (2 %) Qutline: 0,125 in (2 %) Create Contour Cut (Outling)

(@) Build Contours () Build Boxes
() Cutting Grid
Contour Type

Cutting Contour ~
Blue line shows size of
contour around original

A

Outline Options

Corner Style Round ~

Outline (%) 1.96% S

Outline (Units) 0125in —=— Outline setto 0.125”

[[] Dashed Lines

[Jkeep Holes

Images & Effects Options

Inline is set to -1/32 (0.03) inch:
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21 -0.030n (0 %) Outiine: -0,030in (0 %) Create Contour Cut (Outling)

(@) Build Contours () Build Boxes
() Cutting Grid
Contour Type
Cutting Contour v
_ Blue line shows size of
inline inside of original

Qutline Options

Carner Style
Outline (%) -0.48% S
Outline (Units) -0.030 in €—4— OU'[|Ine setto '0.03”

[[]Dashed Lines

[Jkeep Hales

Images & Effects Options

¢ After clicking on Accept, the View Cut only preview now indicates a cut path exists and you're ready to
proceed:

9804 in

\ L Contour cut layer
L / now appears

8.268 in

h

View Print only { View Cut only

What will cut

e Note that text is also a vector shape, thus the contour cut on a text object would be created the same way.

e Also note that there is a Keep Holes option in the Create Cut-Contour window which controls whether or
not the contour is a solid outside cut or contains internal cuts following the shape of the vector:

¢ Keep Holes not marked: A single blue line will

/ be cut around the text
‘.7 \ ‘:' 8 \ (= \/ _ Outline Options.

|

Qutline (%) 3.03% =
Qutline (Units) 0100 in =

[ Dashed Lines

Orespioes ¢——  Leave unchecked

Reset

¢ Keep Holes marked:
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Internal contour cuts are added

Outline Options

Outline (%) 3.03% L
Outline (Units) 0.100in =

[ Dashed Lines

Mrepii: 4——— Check Keep Holes
Reset

lese!

5.03 Engraving Fill

5.03.1 Engraving File Module and Settings

o If you wish to fill in a shape with a line pattern, SignMaster offers an Engraving Module which can be

‘Q\ Plugins

opened by clicking on the Plugins icon and selecting Engraving Module.

e The following window opens and you will see your selected shape has already filled with lines:

Click to add original
shape to Preview

7 Create Engraving Fill l x i

Zoom = . . =
tools 1:1  ZoomToMl Zoomin  ZoomOut View Mode
Tool Settings
ket n
Travel _Hnriznnla\ ~
[ cut Perimeter
[ Cleanup Flange .
Engraving
. — =\ T settings
Preview ——»p £ =, = , Tool Diameter
— — oot
’.—1 — Hatch Offset _J
Click on
Accept
when done
&) -Ancept Cancel

¢ In the top left corner are zooming tools. The View Mode icon can be toggled to add the original selected
shape to the Preview window, if desired:
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/ Original shape appears

Ay
“ Uiy

¢ Toolpath: There are four options in this menu:

o None: nofill pattern is created
@)

S-Sweep: a line fill pattern in which the tool stays down while filling the entire shape:

2. Tool stays down, follows

1. Tool start here and
path of curve, then crosses
to the right

proceeds to the left

3. Tool stays down, follows

path of curve, then crosses
to the left, etc.

o

Line Fill: a line fill pattern in which the tool raises at each side, moves a “row” down, and then
proceeds to the other side:

2. Tool raises

3. Tool drops and \4

1. Tool start here and proceeds to the left
proceeds to the right ——»

/ 4. Tool raises

5. Tool drops and proceeds to
the left, etc.

o

Island Fill: a progressive inset pattern based on the original shape; the tool drops to complete a
path, raises, moves to the next path, drops to complete that path, etc. Some shapes work better
than others with an Island Fill:

¢ Travel: four angles from which to choose, applying only to S-Sweep or Line Fill patterns:

Horizontal

Diagonal - Up
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Vertical Diagonal - Down

¢ Cut Perimeter: turn on this option if you want the original shape to be engraved as well:

Cut Perimeter: not — Cut Perimeter:
checked ' checked
Perimeter of shape is ' Perimeter of shape is

¢ " light, indicating it will o y _~ dark, indicating it will
NOT be engraved also be engraved

¢ Cleanup Flange: turn on this option to have an engraving of the original shape, but along the edges of
the engraving lines. Note that there is also a Flange Offset setting which is a percentage distance from
the original shape to the engraving lines. These settings are typically not needed with small diameter
tools, like the Skycut engraver, so you most likely won’t have a need to activate Cleanup Flange.

¢ Tool Diameter: The size of the engraving tip, pen nib, embossing tip, or other tool. For the Skycut
engraver, use 0.004 inch or 0.1 mm.

¢ Tool Offset: This setting is the distance between the engraving lines as a percentage of the Tool
Diameter. Lowering this setting will decrease the spacing between the lines:

Tool Offset: 34% ' Tool Offset: 15%

Engraving lines are

' much closer together

¢ Hatch Offset: This setting controls the distance from the engraving fill to the outside perimeter of the
original shape, again as a percentage of the tool diameter. A setting of 0% will extend the pattern all the
way to the perimeter:

Hatch Offset: 35% Hatch Offset: 25% Hatch Offset: 0%
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5.03.2 Inside Fills Versus Outside Fills

In certain situations, you might want to reverse the parts of a design that are filled. To do this, add any
outside shape to the design, such as a rectangle, an oval, a heart, etc. The engraving fill automatically fills

the space between this new outside shape and the original design.

¢ For example, if three stars are sent to the Engraving Module, then they will immediately fill with lines
such as this:

¢ If shapes are added around these stars, then the fill pattern reverses to fill the space between the
original shapes and the new outside shapes:

¢ If another shape is added to the outside of these shapes (a large rectangle is added to encompass the
three shapes), then the fill will revert back to the original stars and a line fill is added between the

rectangle and the outside shapes that were added:

-

If, for some reason, you want the outside shape present but NOT have the area between the two shapes
filled, then only select the initial shapes (i.e., the stars) to send to the Engraving Module.
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Appendix A Troubleshooting FAQ’s

Al Communication Issues

| cannot get the Skycut to power on.

e Make sure the power cable is securely plugged into the Skycut’s port on the left side and securely
plugged into a wall socket or a power strip.

o |If it still fails, check the wall socket or power strip with another device, such as a table lamp.

e If you still cannot get the Skycut powered on, contact your dealer.

| cannot get Wi-Fi to work with my Skycut.

e Set the Skycut close to the router when performing the initial setup presented in Section 1.12.2. After
establishing communication, you can test how far the Skycut can be located from your router.

¢ In SignMaster’s Vinyl Spooler window, under the Connection tab, make sure you have selected TCP
and entered the same IP address you selected during setup on the Skycut’s control panel:

Settings

O TCP v Configure
192.168.1.200:8080

& (O Printer

e Make sure your computer is connected to the same router as your Skycut.
o Verify that SignMaster is the selected software on the control panel under Set>Sys Information.

e |f the number you see on the control panel orange strip reads 192.168.16.254, you have NOT
connected to your router. That is the default IP address for a stand-alone connection. You need to
repeat the scan procedure and make sure you see the correct IP Address appear.

e Some routers will not accept 200 or higher as an IP Address assignment. Try 151 instead.

e Some routers assign the same name to both the 2.4G and 5G networks and because the Skycut’'s Wi-Fi
chip only works on 2.4G, you might need to rename your 2.4G network to a different name.

| cannot get USB to work with my Skycut.
e Unplug/replug the USB cable at both the computer and at the Skycut.

¢ In SignMaster’s Vinyl Spooler window, under the Connection tab, make sure you have Direct USB
Port selected under Port Type and the Status says Device Connected. If not, repeat the instructions
in Section 1.12.1.

Connection Method

Port Type *® Direct USB Port v @ Hep
Settings
9 USB Port vid_0483&pid_5750#skycut_368c ~
Status Device Connected
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e Try adifferent USB port on your computer.
o Verify that SignMaster is the selected software on the control panel under Set>Sys Information.

e Try adifferent USB cable.

| had to cancel a cut. Now my Skycut is no longer responding when | click on Cut Now.

e There is a reset button on the right side of the Skycut V. Use a pen or pencil to press and hold for one
second. You should hear a beep.

A2 Operating Issues

The control panel isn’t responding very well.

e Press control panel icons with your finger and not your fingernail. You can also use a black rubber
stylus.

e Make sure the control panel is clean.

My mat is rotating when the Skycut starts to cut!

e Two pinch wheels need to be gripping the mat. Move the mat either left or right so that it is under two
outer pinch wheels and the pinch wheels are aligned under white arrows. Refer to Section 1.09.

e Make sure you are not trying to force the blade to cut too deeply and/or too quickly through a
thick/dense material like chipboard or craft plastic. Slow the speed, decrease the Force, and add more

passes.

My vinyl isn’t feeding evenly while cutting. It starts bunching up on the inside of the end cap.

o Even if you feel the vinyl is aligned properly at the start of the cut, a slight “out of alignment” error will
become more pronounced with a long cut. When you first drop the pinch wheels, use the arrow keys to
feed the vinyl for the length of the cut to make sure it is feeding straight. If not, then about half-way
through the length of the vinyl needed, lift the pinch wheels and realign the vinyl. Continue testing the
alignment until you can verify that the vinyl is sufficiently aligned for the entirety of your project.

The pinch rollers are not tight enough to hold the vinyl I'm cutting. The vinyl is slipping and rotating when | start
the cut.
e The pinch wheels need to be over grit shafts (the dark gray rough areas along the revolving shaft. The

white rectangles will help you align the pinch wheels in correct locations. Also, use outside locations
versus having, say, one pinch on the far right of the vinyl and a second pinch wheel only in the middle.
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| hear a terrible stuttering sound when trying to cut chipboard (or other thick dense material).

That can be a symptom of forcing the blade to cut too deeply and/or too quickly through the chipboard.
Slow the speed, decrease the Force, and add more passes.

I'm trying to do a PNC application and the camera can’t read the marks.

Make sure you have calibrated the Skycut’s camera. The procedure is covered in Section 3.03.
On the control panel, go to Set>Camera and press Set. Make sure the Auto PNC option is marked.

If using the cutting mat, make sure the printout is aligned fairly straight on the cutting mat and the mat is
fairly straight in the cutter.

Make sure the blade holder is over the lower right registration mark when starting the cut.
Are the registration marks printed dark with no streaking or missing ink?

Did you make any changes in the Contour Cutting Wizard after printing and before trying to cut?

The Skycut stopped during a cut.

If the Skycut stops with the head over on the left side of the cutter, you have most likely exceeded the
cutting range. Several things to consider:

¢ Check the width (W) of your project (or the height H if in Landscape mode). It cannot exceed 24.”

¢ Check how far you are moving the head to the left when setting the origin. If your project is 23” and
you moved the head more than 1” to the left, you will send the cut out of range and the cutter will
stop.

If the Skycut stops and the head is not located near the left side:

0 Make sure it's not a communication issue.

¢ You may have exceeded a buffer limit. Try reducing the number of nodes. Select the shapes and go
to Curves>Node Editing>Reduce Nodes (Object).

A3 Cutting/Drawing Issues

I’'m getting some stray cuts added, as if the cutter is going a bit crazy.

Extra stray cuts can occur anywhere, including sharp V-shaped cuts jutting outside the borders of the
project. These are referred to as random cuts and are difficult to diagnose. But based on experiences
reported by owners of professional vinyl cutters, here are some possible causes to check:

¢ Bad or defective USB cable
¢ Cutter is plugged into a power strip that isn’t rated highly

¢ Static electricity (many vinyl pros recommend grounding cutters to prevent random cutting due to
static)

¢ Unknown cause — sometimes a quirk in the file might cause something strange to happen such as a
stray cut or a sudden stoppage. Try altering the file in some way, such as reducing nodes.
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My shapes are drawing (cutting) off the material. What am | doing wrong?
e When setting the origin, make sure you are using the tip of the blade as the reference point and set the
tip inside the corner of the material (not too close to an outside edge).

o Verify that the preview window in SignMaster matches where you expect the shapes to cut as you view
the material loaded into the Skycut itself.

When drawing with the test pen), | have extra lines being drawn.

e Make sure you raise the pen in the blade holder seat on the Skycut before tightening the screw. The
blade holder seat needs to be able to drop the tool down when it reaches the spot to start the shape.
Otherwise, the tool tip will be dragging across the material from the origin to where the shape will begin
and then back to the origin at the end of the “cut”.

I’'m drawing with a pen and there are bubbles at the corners.

e For perfect corners when using a pen, go to the Send to be Cut window and select Pen Mode so that
Blade Offset is set to 0. You do not need an offset for pens (or other tools like embossers and

engravers).
Cutting Todl Presets
Color Mame Cutting Preset Elade Type Blade Preset
M rRed Pen Mode (Tool Oj(Head L) Pen Tool
——» Pen Mode (Tool 0)(Head ~ Edit Reset Include Color

My cut started out fine but by the end of the cut, it’s not cutting through the material.

o Make sure the blade holder housing doesn’t have any bits of material inside of it.

¢ Make sure the screw on the blade holder seat is hand-tight so that the blade holder isn’t slipping
upwards during the cut.

¢ Make sure the cutting mat is clean and sticky and the material is pressed down completely, so that the
material remains stabilized during the cut.

o Make sure the blade isn’t cutting too deep into the mat. This can sometimes cause the material to be
pulled up and away from the mat as the blade releases from the plastic it is cutting.

e Try increasing the Force by ~ 5 — 10.

My cut is clean in some places but not in others. Why am | not getting consistent cutting?

¢ Make sure your material is pressed firmly onto a clean and sticky mat (assuming you are cutting a
material such as paper or cardstock).
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e Your material may require two passes if it's not homogenous or if it is heavily textured. Sometimes
intricate shapes also cut better with two passes.

e Also, if the material has been exposed to humidity, then it will become difficult to cut in one pass. You
can dry both paper and cardstock using a blow dryer or in a very low-temperature oven.

e |f you are cutting vinyl without a cutting mat, check the cutting strip to make sure it is still in good
condition.

I have the outside edges of my chipboard completely taped but I'm not getting clean cuts, even after lots of
passes.

e Taping the edges prevents shifting of the chipboard but it's not enough for stabilizing. You need to
thoroughly press the entire surface of the chipboard onto a clean and sticky mat. Using a brayer is
recommended.

| am getting a lot of tearing in my cuts.

e A number of things can cause tearing so work through this check list:

O Too much blade is exposed. If you see cut lines in your mat or the backing sheet, shorten the blade
exposure. You should only be cutting through the material itself.

O The blade is chipped. Try a different blade.

O The paper is not adhered well to the mat. Make sure the mat is clean, sticky, and the paper is
pressed smoothly and evenly on the surface.

O You may be using too much Force. Try reducing it and doing test cuts.

O You may have too many nodes in the shape. Select the shapes and go to Curves>Node
Editing>Reduce Nodes (Object).

¢ The material itself may be subject to tearing, especially on intricate cuts. Also, if the cardstock has
been exposed to humidity, then the moisture in the material can make it difficult to cut cleanly. You
can dry paper and cardstock using a blow dryer or in a very low-temperature oven.

I’'m cutting very small lettering and the letters are a bit distorted.

e Verify that you are using the correct Blade Offset.

e Try slowing down the cut. Small lettering needs slower speed.

My cut shapes are not the same dimensions as what they are set to in SignMaster.

e Perform the calibration procedure shown in Section 2.08.

My shapes are not completely cutting out. They are still attached to the waste part of the material.

e Make sure you have set an appropriate Overcut setting.

o Make sure the mat is not skewing during the cut. This can happen if even one of the pinch wheels is no
longer centered under a white arrow. It can also happen if the speed and/or pressure is set too high.
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My cardstock is not cutting all the way through. | have the blade all the way out and using the maximum force.

o Please refer to Section 1.07.5. It’'s important to only have as much blade exposed as is necessary to
penetrate the cardstock.

e Do not use more force than is needed. If the cardstock is cutting through about 90% of the cut, then
increase Passes. Some cardstocks do better with a second pass at a lower force.

| calibrated the camera for print and cut but every cut is off by the same amount.

e The calibration can be tweaked using the procedure presented in Section 3.06.1

| calibrated the camera for print and cut and the cuts start off accurate but, by the end of the cut, there is a lot
error.

o This is called “drift” and can sometimes be corrected by slowing the speed and making sure the cuts
aren’t so deep that the blade is causing some drag to occur.

e An alternative solution is to add intermediate registration marks. Refer to Section 3.08.1.

of
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Appendix B Activating Commands

This section shows you how to activate commands in order to add certain functions to the control panel.

Go to Set>Advance settings>System Mode and press the emd... button:

|
System Mode
one head v
double

Fast Scan Mark

The following screen opens. Press Input:

Input command:

Press cmd...

The Input code is entered in the same way as you entered your Network password but since it's a 3-digit
code, you'll begin by pressing the 123 button:

Press 123

Numeric keys appear
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e Enter the required Input code according to the following:
¢ 021: Activate Mark Set
¢ 020: Deactivate Mark Set
¢ 031: Activate Passes Set
0

030: Deactivate Passes Set

e After entering the Input code you need, click on OK and the Input screen will return. The word RUN will
now be highlighted and you can press it. The Skycut will beep once.

a

Enter code by
pressing keys

Input command:

031

Press RUN...

Press OK when done

e Return to the main screen and press USB, the activated button will now appear:

Passes Set now
appears
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